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RESUMEN

El presente trabajo de investigacion se desarrolld en la cuenca del rio Huarmey, que abarca
parte de las provincias Huarmey, Aija y Recuay pertenecientes al departamento de Ancash.
Esta cuenca tiene una region costera, donde las lluvias son escasas, y una region andina
donde se presentan fuertes precipitaciones anuales, siendo esta la zona mas vulnerable a la
erosion hidrica. Sin embargo, en marzo del 2017 se produjo el fendmeno del Nifio Costero,
que origind inundaciones extraordinarias en la region costera. Estas situaciones medio
ambientales permitieron observar zonas sensibles a inundaciones y a la erosion hidrica, las
cuales fueron ubicadas mediante el modelamiento geoespacial. El primer mapa elaborado
fue el de inundaciones extraordinarias, basado en el estudio realizado por Wahid et al. en el
2016, empleando las capas de pendientes, capacidad de infiltracion, factor formay cobertura
donde se localizaron las zonas mas propensas a ser inundadas ante precipitaciones
extraordinarias. La superposicién ponderada de dichas capas, permitio determinar que las
areas urbanas, el valle y los depésitos aluviales presentan una alta vulnerabilidad a
inundaciones. Un segundo modelo de inundaciones se efectué usando el mismo
procedimiento, pero considerando ademas el factor de precipitaciones, lo que permitié una
mejor identificacion de las zonas propensas a inundaciones. El tercer modelo fue de
vulnerabilidad fisica, que mostré que las zonas con vulnerabilidad alta se encuentran en la
parte andina de la cuenca, donde las pendientes y precipitaciones son elevadas. Por Gltimo,
se cuantificd la pérdida de suelo debido a la erosion, con ayuda de la Ecuacién Universal de
Pérdida de Suelo (USLE), la cual requirié de las variables de precipitaciones, suelos,
pendientes y cobertura. Este modelo mostré que las zonas con mayores cantidades de pérdida
de suelo fueron las de vulnerabilidad alta, entre 50 y 200 t/ha.afio; y muy alta, mayores a 200

t/ha.afo.

Palabras clave: SIG, inundaciones extraordinarias, erosién hidrica, USLE, modelo

geoespacial, vulnerabilidad.
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ABSTRACT

The present research work was developed in the Huarmey river basin, which covers part of
the Huarmey, Aija and Recuay provinces from the Ancash region. This basin has a coastal
region with low rainfall, and a mountain region where heavy annual rainfall occurs, making
this zone the most vulnerable to water erosion. However, in March 2017, the phenomenon
known as Nifio Costero occurred, which caused flash floods in the coastal region. These
environmental situations revealed which areas were sensitive to flooding and water erosion,
and were identified through geospatial modeling. First, the flash flood map was developed
based on the study carried out by Wabhid et al. in 2016, using the layers of slope, infiltration
capacity, shape factor and land use/land cover to identify the areas that were most likely to
be flooded as a result of unusually heavy rains. The result of the weighted overlay of these
four layers established that the urban areas, the valley and the alluvial deposits presented a
high vulnerability to these floods. A second flood model was carried out using the same
procedure, but this time the rainfall factor was considered, allowing a better identification of
the flood prone areas. The third model was of physical vulnerability, which showed that the
areas with High vulnerability were located in the highlands of the basin, because of the steep
slopes and heavy rainfall of that region. Finally, the soil loss due to erosion was quantified
thanks to the Universal Soil Loss Equation (USLE), which required the variables of rainfall,
soils, slopes and coverage. This model showed that the zones with the highest amounts of
soil loss were the ones with high vulnerability, between 50 and 200 t/ha.year; and with very

high vulnerability, greater than 200 t/ha.year.

Keywords: GIS, flash floods, water erosion, USLE, geospatial model, vulnerability.
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I. INTRODUCCION

En la actualidad se pueden evidenciar los diferentes efectos del cambio climatico que se
producen a nivel global, y un ejemplo de esto fue el fendbmeno que se presento en la costa
peruana en el afio 2017, donde se registré un aumento significativo de la temperatura en la
temporada de verano y como consecuencia, las precipitaciones en esta zona del Peru
aumentaron a niveles atipicos. De este modo, se produjo el fendmeno denominado Nifio
Costero, el cual, a diferencia del Fendmeno del Nifio, este no se anuncia con anticipacion,
sino que se produce de forma repentina. Durante la temporada del Nifio Costero, las
precipitaciones se incrementaron a niveles altos en zonas donde las lluvias eran escasas, y
esto llevo al origen de inundaciones extraordinarias y procesos de erosion del suelo, tal como
ocurrié en la provincia de Huarmey que, en el 16 de marzo del 2017, se produjo un
desbordamiento de agua que ocasiono fuertes desastres. Por esta razon, es que la prevencion

ante este tipo de desastres naturales es importante, para evitar mayores dafios.

Debido a este escenario atipico, es que se planted la generacion del modelo geoespacial de
Inundaciones Extraordinarias, para simular que efectos puede causar este fendmeno en la
cuenca. Utilizando el programa ArcGIS se llevd a cabo la superposicién ponderada de las
capas de pendientes, capacidad de infiltracion, factor forma y cobertura para localizar las
zonas susceptibles a precipitaciones inusuales. Esta informacion tiene como objetivo ser de
utilidad para las autoridades, y les permita conocer cuales son las regiones que requieren de
mayor atencion para el desarrollo de proyectos de prevencion, y de esta forma se pueda
aminorar el impacto ante este tipo de desastre. De igual forma, se generd un segundo modelo
geoespacial de inundaciones, realizando un procedimiento similar al primero, pero en este
caso tomando en cuenta la informacion de las precipitaciones, para realizar un analisis entre

el primer y segundo modelo y compararlos.

Por otro lado, es importante recalcar que en la parte andina de la cuenca, las precipitaciones
fuertes suceden anualmente, y la poblacion tiene que lidiar con este problema de manera
periddica. Debido a esto, se elabord un tercer modelo geoespacial de vulnerabilidad fisica,
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que mostrd cudles eran las zonas mas propensas a ser afectadas por la erosion hidrica, y para
ello se tomaron en cuenta las capas de pendientes, precipitaciones, geologia, geomorfologia

y cobertura.

Finalmente, se elaboré un modelo geoespacial utilizando la ecuacion USLE, para cuantificar
la pérdida de suelo anual que se producen en la cuenca por la erosién hidrica, el cual requirio
de las variables de precipitaciones, suelos, cobertura y pendientes; y de la aplicacion de
técnicas de Sistema Informacion Geogréafica (SIG). Estos dos tltimos modelos, al igual que
el primero es de gran importancia, ya que en este caso el escenario que se plantea sucede
cada afo.

De acuerdo a lo explicado previamente, el objetivo general de esta tesis fue:

Identificar las zonas vulnerables a inundaciones y procesos de erosion, y cuantificar la
erosion hidrica en la cuenca del rio Huarmey mediante el modelamiento geoespacial y uso

del Sistema de Informacion Geogréfica (SIG).

Del mismo modo, los objetivos especificos fueron:

e Elaborar una base de datos geoespacial con la informacion temaética de capacidad de
infiltracion, cobertura, pendiente, geologia, geomorfologia y precipitacion.

e Realizar el modelamiento geoespacial para identificacion y localizacion de las zonas
vulnerables a inundaciones y erosion hidrica.

e ldentificar y cuantificar las areas de riesgos a erosion hidrica mediante la aplicacién de
la Ecuacion Universal de Pérdida de Suelos (USLE) y el Sistema de Informacion

Geogréfica.



Il. REVISION DE LITERATURA

2.1. ANTECEDENTES

El PerG por su ubicacion geografica y caracteristicas morfoldgicas, esta sujeto a la
manifestacion de diversos fendmenos naturales, entre ellos estdn los peligros
hidrometeorol6gicos, que generan inundaciones en zonas expuestas, los cuales afectan a la
poblacion y sus medios de vida (CENEPRED, 2014). Las inundaciones, traen como
consecuencia lamentables y cuantiosos decesos, miles de damnificados y significativas
pérdidas econdmicas que reducen la calidad de vida y obstaculizan el desarrollo sostenible
del pais (INDECI, 2011).

En el 2017, el Pert fue terriblemente golpeado por lluvias intensas, acompafiadas de altas
temperaturas del mar en la costa durante el verano y el otofio. Este evento se denominé El
Nifio Costero, que es un fenémeno nuevo, aunque similar al Fendémeno del Nifio (Martinez
y Takahashi, 2017). Este fendbmeno generd lluvias costeras inusuales, las cuales conllevaron
a los desbordes de rios y deslizamientos de lodo y piedras, produciendo dafios en las zonas
de cultivo e infraestructura como viviendas, carreteras, puentes, canales de riego, colegios,
hospitales, entre otros bienes publicos y privados (Aguilar y Reyes, 2017). Asi mismo, las
quebradas Rio Seco, Gramadal y Huarmey se activaron y rebasaron la ciudad en pocas horas.
Se formaron cinco huaicos que devastaron la ciudad, resultando en 425 viviendas dafiadas,
146 colapsadas y 23 inhabitables; mientras que 12 instituciones educativas también fueron
afectadas, 11 quedaron inhabitables y otras tres colapsaron. Ademas, tres establecimientos
de salud fueron inundados y a dos de ellos los declararon inhabitables (Urbina, 2017).

Debido a que estos fendmenos producidos por el cambio climético se han producido en otras
regiones, existen diversos trabajos de investigacion sobre las zonas vulnerables a
inundaciones extraordinarias en zonas donde las lluvias usualmente son escasas. Un ejemplo

de estos estudios, fue el realizado por Wahid et al. (2016), quienes mencionan la importancia



de la localizacion de los lugares propensos a las inundaciones para evitar pérdidas
econOmicas y salvaguardar a la poblacién, asi como para la planificacion del uso del suelo.
La zona de estudio de esta investigacion fue en la llanura costera del sudoeste del Sinai,
Egipto, la cual cuenta con caracteristicas geologicas, morfologicas y condiciones climaticas
que son responsables de las inundaciones extraordinarias estacionales que pueden amenazar
la planificacion del uso del suelo en esta area. Por ello, Wahid et al. (2016) realizaron un
trabajo de investigacion para obtener un mapa de indice potencial de inundaciones, mediante
el modelamiento geoespacial de informacion tematica de los datos de uso de suelo/cobertura
vegetal, capacidad de infiltracion, factor formay pendiente. En este estudio, se concluy6 que
los dos factores que mas influencia tenian en el potencial de inundaciones extraordinarias
fueron las pendientes y la capacidad de infiltracion. El fin de esta investigacion fue prevenir
la pérdida de vidas, dafos a la propiedad e impactos ecoldgicos por inundaciones, antes de

que los planes de desarrollo se inicien en esta zona.

Por otro lado, a pesar de que estos eventos extraordinarios ocasionados por el cambio
climatico deben de tomarse en cuenta para el desarrollo de modelos geoespaciales, las
precipitaciones de altas magnitudes que se producen anualmente en la zona andina, generan
desastres a causa de la erosion hidrica, por lo que también es de importancia la generacion

de modelos tomando en cuenta el factor de las luvias.

Los procesos de erosion del suelo pueden producirse de manera progresiva a lo largo del
tiempo, siendo imperceptible, o de manera abrupta con una pérdida significativa de suelo en
corto tiempo. Asi mismo, la erosion puede producirse tanto de manera natural por efectos
del agua o el viento, como por la actividad humana. Esta pérdida de suelos que se producen
tiene como consecuencias la degradacion del suelo, la reduccion de la productividad agricola

y la contaminacion de fuentes cercanas de agua (Telkar y Pote, 2014).

La cuenca Huarmey esta comprendida por zonas de costa y andina, donde la vegetacion se
produce a diferentes niveles. En la parte baja de la cuenca, la vegetacion es escasa y la que
existe solo depende de la zona agricola de los valles, abarcando un area minima. En la zona
alta de la cuenca, es donde se encuentra la mayor vegetacion de la cuenca, sin embargo, esta
se va reduciendo cada vez mas producto del sobre pastoreo y la quema de pastos, trayendo

como consecuencia de esto una mayor erosion de los suelos (Manrique et al. 2018).



Existen diferentes trabajos de investigacion en las cuales se han generado modelos
geoespaciales, para determinar las zonas mas vulnerables a erosién hidrica, asi como para
cuantificar la pérdida de suelo que se produce al afio. Montes-Leon et al. (2011), realizaron
un estudio para elaborar el Mapa Nacional de Erosién Potencial, que tuvo como finalidad
encontrar las areas mas vulnerables de México a la erosién potencial, asi como la cantidad
de suelo que se perdia al afio, utilizando las herramientas SIG y la Ecuacidén Universal de
Pérdida de Suelos (USLE). La razén por la cual este mapa era de importancia, fue el registro
de diferentes problemas surgidos a causa de la erosion hidrica. La pérdida de suelos que se
venia produciendo en la region, origind la desaparicion de zonas agricolas, la disminucién
en los niveles de nutrientes de la tierra, dafios en el &rea urbana donde llegaban los materiales
acumulados, alteraciones en el ciclo hidrolégico, impactos negativos en la biodiversidad y
maltrato a las obras hidraulicas, disminuyendo su vida util. Estas dificultades que se han
presentado en México, debian ser atendidas, para lo cual el mapa de erosion de la zona
permitio, ademas de la identificacion de las zonas més susceptibles, el reconocimiento de
los lugares donde se puedan desarrollar planes de conservacion, y otros proyectos, como la
reforestacion, que disminuyan el impacto de la erosion en el ambiente (Montes-Leon et al.
2011).

2.2. VULNERABILIDAD

En el marco de la Ley N° 29664 del Sistema Nacional de Gestion del Riesgo de Desastres y
su Reglamento (D.S. N°048-2011-PCM) se define la vulnerabilidad como la susceptibilidad
de la poblacion, la estructura fisica o las actividades socioecondmicas, de sufrir dafios por
accion de un peligro o amenaza (CENEPRED, 2014).

INDECI (2006) define la vulnerabilidad, como el grado de debilidad o exposicion de un
elemento o conjunto de elementos frente a la ocurrencia de un peligro natural o antropico de
una magnitud dada. Es decir, la predisposicion intrinseca de como un elemento
(infraestructura, vivienda, actividades productivas, grado de organizacidn, sistemas de alerta
y desarrollo politico-institucional, entre otros), puede sufrir dafios humanos y materiales
cuando no se ha invertido lo suficiente en obras o acciones de prevencion y mitigacion y se

ha aceptado un nivel de riesgo demasiado alto.



Se han establecido los siguientes tipos de vulnerabilidad: Fisica, ambiental y ecoldgica,
econOmica, social, educativa, cultural e ideoldgica, politica e institucional, y, cientifica y
tecnoldgica (INDECI, 2011).

Por otro lado, SINAGERD (2014) alerta que el 46 por ciento del territorio nacional se
encuentra en condiciones de vulnerabilidad Alta a Muy Altay que, ademas el 36.2 por ciento
de la poblacion nacional (9°779,370 habitantes aproximadamente) ocupan y usan este

espacio territorial.

2.3. INUNDACION

La inundacion es un proceso de desbordamiento del agua fuera del cauce natural o artificial.
Se producen cuando las lluvias intensas o continuas sobrepasan la capacidad de campo del
suelo, el volumen de transporte del rio es superado y el cauce principal se desborda e inunda
los terrenos circundantes (INDECI, 2011). Segun las estadisticas, el 40 por ciento de las
victimas por desastres naturales, se debieron por inundaciones, convirtiéndolo en uno de los
fendmenos mas letales. Esto es reforzado por el hecho de que mas de la mitad de la poblacién
mundial vive en las costas y a lo largo de rios y estuarios. (Martinez, 2007).

ElI INDECI (2011), clasifica las inundaciones segtn su duracion y su origen. Por su duracion
se clasifican como inundaciones réapidas e inundaciones estaticas; y segun su origen, como
inundaciones pluviales, inundaciones fluviales e inundaciones por operaciones incorrectas

de obras de infraestructura hidraulica o rotura.

2.4. INUNDACION EXTRAORDINARIA

El Servicio Meteoroldgico Nacional de Estados Unidos, citado por UCAR (2010), establece
que este tipo de inundaciones se producen rapidamente con caudales muy altos y en zonas
generalmente secas, a causa de precipitaciones intensas. Se estima que el tiempo aproximado
que tarda en ocurrir este evento es de seis horas, aunque esto puede variar en diferentes

lugares.

Asi mismo, las inundaciones extraordinarias suelen caracterizarse por las fuertes

precipitaciones y el rapido desarrollo de escorrentia. De estos dos factores, las caracteristicas
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del suelo donde caen estas precipitaciones, son las mas relevantes para el desarrollo de
predicciones de este fendmeno (UCAR, 2010).

Las propiedades del suelo como la humedad, alteraciones a la superficie, permeabilidad y
perfil vertical; y las caracteristicas de la cuenca como tamafio, forma, pendiente y cobertura
de suelo, son las que influyen en la produccién de escorrentia y por ende en la ocurrencia de
inundaciones extraordinarias, razon por la cual forman parte de la data a tener en cuenta para
la prediccion de estos eventos (UCAR, 2010).

2.5. EL NINO COSTERO

El Nifio Costero es un evento climatico que, independientemente de los procesos fisicos que
lo puedan originar, esté relacionado a la presencia de aguas anomalamente calidas en forma
persistente durante varios meses en la region del Océano Pacifico, principalmente a lo largo
de la costa norte del Per( y de Ecuador. En algunos casos las aguas calidas pueden extenderse
hacia la costa central y sur del Per(. Este evento puede estar asociado a lluvias muy fuertes
durante el verano en las zonas medias y bajas de la costa norte e inclusive de la costa central,
asi como a impactos en el ecosistema marino peruano, de acuerdo a su magnitud y
persistencia (IMARPE, 2018).

La terminologia de “El Nifio Costero” fue introducida formalmente por el Comité
Multisectorial encargado del Estudio Nacional del Fenémeno El Nifio (ENFEN) integrado
por el Instituto del Mar del Perd, Servicio Nacional de Meteorologia e Higrologia
(SENAMHI), Instituto Geofisico del Pert (IGP), Direccién de Hidrografia y Navegacion
(DHN), Instituto Nacional de Defensa Civil (INDECI) y la Autoridad Nacional del Agua
(ANA) en el afio 2012, con el fin de precisar las definiciones y conceptos que por afios han

causado confusion entre la poblacion.

2.6. EROSION

De acuerdo a Tayupanta (1993), el suelo al estar en contacto con factores externos fisicos o
quimicos, puede tender a presentar cambios en la superficie, y a este desgaste del material
del suelo se le conoce como erosion. Los suelos van perdiendo parte de su estructura durante

el afo, y esto se debe a dos factores, que son el aire y el agua (Telkar y Pote, 2014).
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A nivel global de la superficie terrestre, existen diferentes tipos de erosion que pueden
agruparse en seis categorias: erosion hidrica, erosion eolica, erosion fluvial, erosion marina
y litoral, erosion glaciar y erosion karstica (Arias, 2006). Para Kirkley y Morgan (1984);
citado por Arias (2006), a la escala reducida de un talud y zonas aledafias, los Unicos que

revisten importancia son la erosion e6lica y sobre todo la erosion hidrica.

2.7. EROSION HIDRICA

La erosién hidrica es el proceso de desprendimiento y arrastre acelerado de las particulas del
suelo causado por la accion del agua que disminuye la productividad de los suelos y afecta
la salud de los ecosistemas. La erosion hidrica es el principal problema que compromete la
sustentabilidad de todos los sistemas productivos. La estimacion de pérdidas de suelo por
este fendmeno es una informacién de suma importancia para la planificacion y toma de

decisiones a diferentes niveles (Gaitan et al. 2017).

Arias (2006) menciona cuatro tipos de erosion hidrica: La erosion laminar, erosion por

arroyada anastomosada, erosion por surcos y la erosion carcavas.

e Erosion Laminar: Para Howell et al. (1979); citado por Arias (2006), consiste en la
remocién de delgadas capas de suelo producida por el agua que fluye por terrenos
uniformes y de poca pendiente, ocasionando la pérdida de la porcion de suelo con mayor
contenido en materia orgénica, causando un empobrecimiento en elementos nutrientes y

un descenso de la capacidad de almacenamiento de agua.

e Erosion por Arroyada Anastomosada o Trenzada: La lamina de agua no suele discurrir a
mucha distancia, concentrandose en las pequefias depresiones e irregularidades del
terreno, formando pequefios hilillos de corriente no jerarquizado y de trayectoria

cambiante, siendo sus efectos similares a los producidos por el flujo laminar.

e Erosion en Regueros o Surcos: Es la forma de erosion mas facilmente perceptible, tiene
su origen a causa del escurrimiento superficial del agua que se concentra en sitios
irregulares o depresiones superficiales del suelo desprotegido o trabajado

inadecuadamente (FAO, 2000; citado por Cabrejos, 2016).
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e Erosion por Carcavas: es el estado mas avanzado de la erosion por surcos. Dependiendo
de la pendiente y la longitud de la ladera del terreno, el flujo concentrado de agua provoca
el aumento de las dimensiones de los surcos, hasta transformarse en zanjas de gran

tamarfio llamadas cércavas.

El proceso de erosion hidrica involucra tres etapas en las cuales se producen dafios
importantes: preparacion del material (desprendimiento y remocién), transporte y

sedimentacion.

En la etapa de preparacion del material se produce una alteracion de la estructura superficial
del suelo, destruccién de agregados, formacion de costras y sellos, alteracion de la relacion
infiltracion/escurrimiento y pérdida de fertilidad del suelo. En la etapa de transporte se
completa la pérdida de las particulas del suelo (materiales coloidales como materia organica,
humus, y nutrientes) iniciada en la etapa anterior, y se genera el escurrimiento superficial
que produce distintas formas de erosion (laminar, en surcos y/o en carcavas) y dafios a la
infraestructura. En la etapa de sedimentacion el depésito del material puede destruir cultivos,
dafar la infraestructura (caminos, vias férreas, etc.) y colmatar y reducir la capacidad de

represas y embalses (Gaitan et al. 2017).

2.8. FACTORES QUE INFLUYEN EN LA EROSION HIDRICA

Entre los factores que determinan la erosion hidrica, Bascufian (2010) menciona que son,
tectonicos, litoldgicos, edafoldgicos, morfoldgicos, e incluso antrdpicos, y que en conjunto

forman un entramado complejo interdependiente a lo largo del tiempo.

Morgan y Rickson, citado por Arias (2006) sefialan que, a la escala reducida de un talud, y
a corto plazo, los factores que controlan la erosion son el clima con su agresividad o
erosividad, la naturaleza del terreno con su mayor o menor erosionabilidad, el relieve
topografico con su pendiente, longitud y forma de la vertiente, y la cobertura vegetal propia

o implantada en su superficie.

El analisis y la evaluacién de la vulnerabilidad del territorio a los procesos erosivos y a las

inundaciones por accion de las aguas pluviales, implica conocer las caracteristicas del
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material parental, tipos de suelos, variabilidad climatica, tipos de cobertura vegetal, formas
de relieve, pendiente, entre otros, que son los factores mas importantes que determinan la
vulnerabilidad de una zona. En tal sentido, el grado de vulnerabilidad a la erosion debera ser
definido sobre la base de su geologia, geomorfologia, suelos, clima, pendiente y cobertura

vegetal, cuyo andlisis e integracion se realiza con el SIG (Montalvo, 2015).

2.8.1. Precipitacion

Las areas con grandes precipitaciones son propensas a ser mas vulnerables que las areas con
baja precipitacion. Para Vasquez (2000); citado por Cabrejos (2016), establece que las
precipitaciones que se producen en una zona, guardan una fuerte relacion con la escorrentia
que se genere en el lugar, asi mismo el factor viento influye en el impacto que tenga las
precipitaciones en el suelo, ya que puede alterar la velocidad de la lluvia, variando el angulo

de impacto, produciéndose una fuerte erosion.

2.8.2. Pendiente

Es uno de los factores que valora el grado de inclinacion del sustrato litolégico en las
diferentes geoformas. Se debe tener en cuenta que las zonas con poca inclinacion o
pendiente, son menos vulnerables a la erosion en comparacion de las zonas con pendientes

muy empinadas.

2.8.3. Cobertura Vegetal

Se debe considerar los parametros de fisonomia, tamafio y porte de las especies que habitan
en la unidad; asi como tambien la cobertura, que se refiere a la densidad de especies
vegetales, y al nUmero de estratos. Por lo tanto, zonas de mayor cobertura arborea y mayor

ndmero de estratos, son menos vulnerables a la erosion.

2.8.4. Tipo de Suelos

Para Vasquez (2000); citado por Cabrejos (2016), la resistencia que tenga un suelo ante el

desprendimiento de sus particulas por efecto de fuertes escorrentias y la capacidad de
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infiltracion del suelo, sera determinado por las propiedades fisicas de estructura, textura,

contenido de materia organica, entre otros.

2.8.5. Geologia

Para el analisis de esta variable se debe tener en consideracion el tipo de material parental,
el ambiente de depositacion, el grado de alteracion, el grado de cohesidn de los minerales
que forman las rocas y en menor grado los procesos enddgenos y exdgenos que afectaron las
secuencias litoestratigraficas. Debido a esto, toda zona que posee material parental
inconsolidado es mas vulnerable, ya que poseen baja estabilidad por su falta de cohesion y
estd expuesta a la constante alteracion de la naturaleza. Por otra parte, las zonas con material

mas consolidado, como las rocas de alta compactacidn, son menos vulnerables a la erosion.

2.8.6. Geomorfologia

Estan estrechamente relacionadas con la variable geoldgica a través de los parametros
morfométricos como la declividad, amplitud altimétrica y los grados de diseccion,
condicionando la accion de los procesos geodinamicos que también califican cuando
interacttan. En el caso de la erosion, las formas de tierra tipo terrazas altas o medias son
menos vulnerables, que las formas montafiosas. Por otro lado, los relieves planos o terrazas
bajas, cercanos a las margenes de los rios son mas inestables por su exposicion permanente

a los fendmenos naturales como las inundaciones.

2.9. SISTEMA DE INFORMACION GEOGRAFICA (SIG)

Actualmente, se puede recopilar una gran cantidad de datos sobre diferentes temas, y si estos
se encuentran georreferenciados, existe una manera eficiente de manejar esta data, la cual es

mediante los sistemas de informacién geogréfica.

El Sistema de Informacion Geogréfica (SIG) se define como un sistema completo, formado
por cinco componentes (personal capacitado, datos espaciales y descriptivos, métodos
analiticos, hardware y software), cuyo proposito es proporcionar un marco espacial para
apoyar las decisiones para el uso inteligente de los recursos de la tierra y gestionar el entorno

creado por el hombre (Zeiler, 1999).
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Por otro lado, Kuroiwa (2002) menciona que los SIG estdn cambiando los procedimientos
de administracion de datos y los procesos analiticos, al emplearse para ayudar a la toma de
decisiones, al proporcionar varias alternativas para la planificacion del desarrollo,
incluyendo datos socioeconémicos, la conservacion del medio ambiente, y el manejo
adecuado de los recursos del pais. Afirma también que estan siendo utilizados para modelar
los peligros naturales, la vulnerabilidad y los riesgos, con resultados de suma utilidad en los

escenarios geograficos.

El software del sistema tiene la capacidad de soportar modelos o representaciones de la
realidad atentos a puntos de vista, percepciones o intereses heterogéneos. Ello se plasmara
tanto en la informacidn que se seleccionara, como en la manera de organizarla en el programa
(Moreno et al. 2008).

Segun Buzai (2008), son dos modelos utilizados computacionalmente para representar la
informacidn obtenida de las diferentes unidades espaciales: el modelo raster y el modelo

vectorial.

El modelo raster se caracteriza por dividir el espacio geografico mediante una matriz
cuadriculada, donde cada celda tiene informacion correspondiente a la caracteristica
dominante en ella. Cada celda es una localizacion, técnicamente se denomina pixel (picture
element) y es la unidad minima de representacion espacial. Por otro lado, el modelo vectorial
organiza los datos geograficos en base a la perspectiva de bases de datos relacionadas y a
partir de esto permite trabajar digitalmente utilizando las tres entidades graficas que se usan
para confeccidn de mapas: puntos, lineas y areas. Hoy en dia los SIG combinan ambos tipos

de estructuras segun la precision de los datos con los que se va a operar.

Los softwares mas avanzados, como el ArcGIS, proporcionan al usuario un conjunto de
objetos predisefiados listos para ser usados, asi como también la posibilidad de desarrollar
objetos nuevos. De esta manera se dispone de la capacidad de construir una representacion
del espacio geografico mas realista y poderosa, pero también mas compleja (Zeiler, 1999);
pudiendo desarrollar tareas tanto simples como avanzadas, incluyendo mapeo,

administracion de datos, analisis geogréafico, edicidn de datos y geoprocesamiento.
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2.10. TELEDETECCION

Cuando se quiere caracterizar alguna region de interés, se pueden realizar diferentes
actividades, por ejemplo, un levantamiento topografico, muestras de tipo de suelo, visitas de
campo, entre otras muchas méas. Sin embargo, cuando toda esta informacion va de la mano
de una fotografia aérea o espacial de la zona de estudio, esto logra que toda la data tomada
previamente, cobre mayor sentido, ya que estas fotografias se convierten en herramientas
audiovisuales que permiten que cualquier usuario distinga con claridad las propiedades y

atributos que posee la region y cdmo éstas pueden variar a lo largo del tiempo.

Chuvieco (1995) indico que la definicion de teledeteccion incluye tanto la toma de imagenes
desde el espacio o el aire de un area de estudio, asi como de los procedimientos que siguen
para tratar dicha data segun el uso que se le va a dar. Existen dos maneras de realizar una
percepcion remota, la primera es la teledeteccion aérea, realizada mediante aviones
especiales y la segunda es la teledeteccidn espacial, que es la recopilacion de fotografias

mediante sensores espaciales, siendo ésta el método mas innovador.

Actualmente, debido a que existe la disponibilidad de imagenes satelitales de manera
gratuita, la percepcion remota por medio de satélites es la que sera definida en el presente

estudio.

De acuerdo con Labrador Garcia et al. (2012), la teledeteccion espacial cuenta con siete

componentes para su desarrollo:

e EIl primero de éstos, es la fuente de energia que permite iluminar los elementos de
estudio. El principal ejemplo es la radiacién proveniente del sol (A).

e Elsegundo, es la atmosfera, la cual es atravesada por la energia que viaja de la fuente al
objeto de interés (B).

e EI tercero, es el conjunto de elementos sobre la superficie terrestre, que se desea
observar. Los objetos se distinguen por la diferente radiacion que refleja cada uno de
ellos (C).

e EIl cuarto es el sensor que se encuentra en el satélite, cuya funcion es recopilar la

radiacion reflejada (D).
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El quinto es la estacién que recibe la data de la radiacion reflejada y la procesa para
convertirla en imagenes digitales (E).

El sexto elemento es el proceso para interpretar la imagen digital con el fin de obtener
informacion de los objetos de interés (F).

El Gltimo componente consiste en la aplicacion de estas imé&genes para el desarrollo de

estudios, resoluciones de problemas de la zona, etc (G).

Figura 1: Componentes para la teledeteccién espacial
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2.10.1. Radiacién Electromagnética

La fuente de energia al entrar en contacto con los elementos sobre la superficie terrestre,
cada uno de estos objetos emitira y/o reflejara una radiacion electromagnética diferente, que

se denomina signatura espectral (Castafio Fernandez et al. 1996).

Reflectividad (%)
A

Suelo
Agua
Vegetacion sana

Vegetacion enferma
— Nieve

80

60

40

20

0,4 0,8 1,2 1,6 2,0 24 2.8
Longitud de onda (um)

Figura 2: Firmas espectrales tipicas de distintas cubiertas (Fuente: Tomado de Piazzese
y Ofate 2004)

La energia electromagnética, que es emitida por los objetos, estd conformada por la longitud
de onda y la frecuencia. El espectro electromagnético es donde estos dos componentes se
muestran de forma continua. Asi mismo, las bandas espectrales son diferentes fragmentos
del espectro, que son captados por los sensores. Debido a que el ojo humano, es un sensor,
¢éste puede percibir una parte del espectro, denominada “Espectro Visible” (Schomwandt,

2015).

Segun Labrador Garcia et al. (2012), las unidades en que se mide la longitud de onda
electromagnética son los micrometros (um, 10 m.) o nanémetros (nm, 10° m.). De esta
manera, los valores de longitud de onda se reflejan en el espectro en dichas unidades, lo que
permite su division en diferentes zonas, como la visible, ultravioleta y demas, que se

muestran en la Figura 3.
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Espectro electromagnético.

Longitud de onda (A) en metros.
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Figura 3: Espectro Electromagnético (Fuente: UNAM 2016)
2.10.2. Resolucion de las imagenes satelitales

Existen diferentes tipos de sensores espaciales, que obtienen informacion de la superficie
terrestre en distintas resoluciones. Los cuatro tipos de resoluciones que posee una imagen
satelital son la espacial, la radiométrica, la espectral y la temporal. Estas cuatro resoluciones
permiten al usuario distinguir entre todas las imagenes que se cuente de una regién de interés,

para que utilicen las adecuadas, dependiendo de la aplicacion que se les quiera dar.

e Resolucion Espacial: Las imagenes satelitales estan compuestos por un conjunto de
pixeles, que son la minima unidad que capta un sensor remoto. Esta resolucion indica la
longitud que posee el pixel de la imagen. Por ejemplo, si se comparan dos imagenes,
donde la primera cuente con una resolucion de 0.5 m., que es la longitud del pixel, y la
segunda posea una resolucion de 2 m., la primera permitird visualizar objetos mas

pequerios, que en la segunda no podran ser identificables (Labrador Garcia et al. 2012).
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Figura 4: Comparacion de dos imagenes con diferente resolucion espacial (Fuente:
Adaptado de SATELMAC, citado por Labrador Garcia et al. 2012)

e Resolucion Radiométrica: cada sensor posee la capacidad de detectar diferentes niveles
de radiancia espectral, es asi que cuando un sensor puede captar mayores variaciones de
radiancia, éste posee una resolucion mayor que una gque detecta menos variaciones. Si se
toma como ejemplo un sistema fotografico, su resolucion radiométrica dependera del
numero de los diferentes tonos de grises que capte el sensor (Chuvieco, 1995). Asi
mismo, en el caso de los sensores espaciales, con los que se obtiene una imagen digital,
la resolucion radiométrica depende de la cantidad de bits que se requieren para que un
pixel sea almacenado, es asi que, un sensor de 8 bits, se traduce en 28 = 256 Niveles

Digitales que percibira el sensor (Sarria, 2003).

Figura 5: Comparacion de resolucién radiométrica (Fuente: Adaptado de Chuvieco, citado

por Roberto et al. 2018)
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e Resolucion Espectral: este indicador permite saber cuantas bandas espectrales capta un
sensor, asi como su localizacion en el espectro electromagnético y el ancho de banda que
poseen. Mientras el sensor capta un mayor numero de bandas, la resolucion sera mejor;
sin embargo, la eleccion de las bandas dependera del uso que se les dé a las imagenes
(Roberto et al. 2018).

QuickBird
Pancromatica

Multiespectral = == fe

WorldView-1
Pancromatica

WorldView-2
Pancromatica
Multiespectral F I EE .
400 500 600 700 800 900 1000 1100

Longitud de onda (nm)

Figura 6: Comparacion de bandas espectrales de diferentes sensores (Fuente: Tomado de
Labrador Garcia et al. 2012)

e Resolucion Temporal: es el tiempo que toma un sensor. para volver a tomar una imagen
de una misma area de la superficie de la Tierra. Es el periodo que le toma revisitar una

misma zona (Roberto et al. 2018).

2.11. IMAGENES SATELITALES: SENTINEL-2

En este estudio se utilizaron las imagenes satelitales de Sentinel-2. De acuerdo a ESA (2012),
el Sentinel-2 es una mision desarrollada por el programa Copernicus de la European Space
Agency (ESA) y esta conformado por dos satélites idénticos, el Sentinel-2A (lanzado el 23
de junio del 2015) y el Sentinel-2B (lanzado el 07 de marzo del 2017), que vuelan en lados

opuestos de la misma oOrbita simultineamente. Ademas, cuenta con una camara
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multiespectral (MSI) con 13 bandas espectrales y un ancho de barrido de 290 km., cuyas

imagenes tienen las siguientes resoluciones:

e La resolucion espacial de 4 bandas espectrales es de 10 m. (figura 7), la de 6 bandas es
de 20 m. (figura 8) y la de 3 es de 60 m (figura 9).

SWIR
0m
w | %00 1200 1400 1650 1800 2000 20 2800
nm nm nm ne nn nm n nn nm
Band 8 (}52 nm)
Band 4 (665 nm)|

Figura 7: Bandas 2, 3, 4 y 8 con resolucion espacial 10 m. (Fuente: Tomado de ESA 2012)

00 60 o 000 12m 1 1600 150 2000 % 40
nm ~m L nm am nm nm am nm nm nm
i‘“m’ T3 (1630 o)

Band 7 (783 nm]

Band 6 (740 nm) |

Figura 8: Bandas 5, 6, 7, 8a, 11 y 12 con resolucion espacial 20 m. (Fuente: Tomado de
ESA 2012)
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Figura 9: Bandas 1, 9 y 10 con resolucion espacial 60 m. (Fuente: Tomado de ESA 2012)

e Laresolucién temporal de cada satélite es de 10 dias, pero en conjunto es de 5 dias en la
linea ecuatorial con condiciones climaticas de cielo despejado

e Laresolucion radiométrica es de 12 bits.

e La resolucion espectral de las imagenes del Sentinel-2A y Sentinel-2B se presentan en
la Tabla 1.

Tabla 1: Resoluciones espacial y espectral de los sensores Sentinel-2 (Fuente: Tomado de
ESA 2012)

Sentinel-2B

Resolucién Numero de Banda i
Espacial (m) Longitud de onda (nm) L::E:l(]:r:f

2 (azul) 496.6 492.1
3 (verde) 560.0 559
4 (rojo) 664.5 665
8 (IR cercano) 835.1 833
5 (red edge) 703.9 703.8
6 (red edge) 740.2 739.1
7 (red edge) 782.5 779.7
8a (red edge) 864.8 864
11 (SWIR) 1613.7 1610.4
12 (SWIR) 2202.4 2185.7
1 (aerosoles) 443.9 4423
9 (vapor de agua) 945.0 943.2
10 (nubes) 13735 1376.9
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Asi mismo, los productos que genera Sentinel-2 han sido agrupados de acuerdo al nivel de
procesamiento en la que se encuentra la imagen multiespectral. El Nivel-0 representa la data
comprimida sin procesar que serd la base para obtener los demas productos. Luego, se
obtiene el Nivel-1a, que es la data sin procesar descomprimida. En el Nivel-1b, la imagen es
corregida radiométricamente en valores de radiancia en techo de atmosfera, o Top-Of-
Atmosphere (TOA), y se provee un modelo geométrico refinado que serviré en el siguiente
nivel de procesamiento. El producto en el Nivel-1c es una orto-imagen en la proyeccion
UTM/WGS84, obtenida gracias al uso de un DEM (90 m.); ademas, cada banda espectral
fue redimensionada, generando imégenes con distancias entre los centros de los pixeles
medidos en el suelo, o Ground Sample Distance (GSD), de 10 m., 20 m. y 60 m. de acuerdo
a la banda; de igual forma, la reflectancia por pixel es calculada en TOA (codificada en 12
bits) y se generan las méascaras de nubes y suelo/agua (ESA, 2012). Finalmente, en el Nivel-
2a se obtiene un producto con correcciones atmosféricas, que resulta de la transformacion
de la reflectancia TOA a una reflectancia a nivel de superficie, o Bottom-Of-Atmosphere
(BOA) de lo generado en el Nivel-1c, y de igual forma se incluye una clasificacion de
escenas (nubes, sombra de nubes, vegetacion, suelos/desiertos, agua, nieve, etc.), segin ESA
(2019). Del total de productos hallados en los diferentes niveles (0, 1a, 1b, 1cy 2a), Sentinel-
2 solo pone a disposicion del publico las imagenes en el Nivel-1c y Nivel-2a, los cuales
podran ser utilizados para trabajos de gestion de riesgo, ordenamiento territorial, agricultura,
entre otros; y en el caso del presente estudio, estas imagenes fueron empleadas para hallar la

capa de cobertura de la cuenca Huarmey.

2.12. MODELAMIENTO GEOESPACIAL

El modelamiento es un procedimiento donde se realiza la integracion de capas tematicas
existentes y el disefio de un sistema para la creacion de nuevos mapas, y poder efectuar un
analisis de datos correcto. De esta manera, para realizar el modelamiento, el analista debe
organizar los procedimientos necesarios para disefiar e identificar toda la data necesaria para
el estudio. EI modelo resultante sera una representacion grafica simplificada de la realidad,
que servira como fuente de documentacion y referencia para futuros estudios. La precision
del modelo final, seré definida por la calidad de los datos recogidos. La principal razon para
construir un modelo, es su uso en la prediccidén de eventos desconocido, por ejemplo, la
longitud de un elemento, el cual no puede ser medido de manera directa o la condicion futura

de un fendmeno de interés (Trodd, 2005).
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Una de las etapas mas importantes en el procedimiento para construir un modelo
geoespacial, es la identificacion de factores que influyen en el estudio que se planea realizar.
Dependiendo de cada modelo, se preparan matrices donde se representara el modo y el peso
en el que las variables y los atributos influirdn. De igual forma, se asignan calificaciones a
los atributos de los submodelos, mediante el software del Sistema de Informacion Geogréfica
utilizado. (Trodd, 2005 y Rodriguez, 2007).

De acuerdo con Montalvo (2015), se lleva a cabo una integracion de variables en un
esquema, tal como se muestra en la Figura 10, el cual es un ejemplo para obtener el mapa de
vulnerabilidad. Cada variable posee un valor de acuerdo a la incidencia en el objetivo del

modelo.

MAPA DE _
PRECIPITACION

L

¥

MAPA DE PENDIENTES

MAPA DE VEGETACION =

MAPA DE
VULNERAEBILIDAT

¥

MAPA DE SUELOS

MAPA GEOLOGICO

¥

MAPA
GEOMORFOLOGICO

¥

Figura 10: Integracion de variables (Fuente: Tomado de Montalvo 2015)
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2.13. METODO DE LA ECUACION UNIVERSAL DE PERDIDA DE SUELOS
(USLE)

El Método de la Ecuacion Universal de Pérdida de Suelos (Universal Soil Loss Equation,
USLE), fue desarrollado en Estados Unidos por Wischmeier y Smith en 1965 y modificado
en 1978. Esta ecuacion evalta principalmente la erosion laminar o erosion “entre surcos” y
la erosion en surcos en forma conjunta, no asi a la erosion por escurrimiento o “flujo
concentrado” cuya expresion maxima es la formacion de carcavas (Marelli, 1988; citado por

Gaitan et al. 2017).

Mancilla (2008) afirma que el método USLE permite predecir la pérdida anual de suelo por
hectarea y también precisar las técnicas mas apropiadas para el laboreo del suelo, en especial
para cultivos agricolas. Por otro lado, Gaitan et al. (2017) menciona que la USLE es un
método que se puede aplicar en cualquier regién, de alli el termino universal, ya que
considera los principales factores que intervienen en el proceso de erosion hidrica
(precipitaciones, suelo, relieve, coberturas y practicas de conservacion); ademas permite

predecir la erosion actual y realizar simulaciones con diferentes escenarios.

La representacion matematica de la Ecuacion Universal de Pérdidas de Suelo es:

A=R*K*L*S*C*P

En donde:

A = es la pérdida de suelo total (t/ha.afo)

R = es el indice de erosividad de la precipitacion (MJ.mm/ha.h.afio)
K =es el factor de la erodabilidad del suelo (t.ha.h/ha.MJ.mm).

L = es el factor de longitud de la pendiente

S = es el factor de inclinacién de la pendiente

C =es el factor de la cobertura vegetal

P = es el factor de préacticas de conservacion
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2.13.1. Factor de Precipitacion (R)

Este indice climético expresa la energia potencial de las precipitaciones y su escorrentia, que
originan la erosion de una region determinada (Montes-Leon et al. 2011). De este modo,
cuando las lluvias que se producen son més intensas y duran por mayor tiempo, mayor es la

erosion potencial producida en la zona (Stone y Hilborn, citado por Chadli 2016).

De acuerdo con Wischmeier y Smith, citado por Chadli (2016), este factor se obtiene de la
multiplicacién de la intensidad maxima de la precipitacion en un intervalo de 30 minutos

con la energia cinética producida.

E130 = EC X 130

Donde:
Elso = Indice de erosividad de la lluvia (MJ.mm/ha.h)
Ec = Energia cinética total de la lluvia (MJ/ha)

Is0 = Maxima intensidad de la lluvia en 30 minutos (mm/h)

La ecuacién de Wischmeier y Smith depende de la recoleccion de data de intensidad de las
lluvias en periodos corto de tiempo, sin embargo, debido a la dificultad para obtener esta
informacidn, se pueden utilizar otras férmulas. Ramos Taipe (2001) indic6 que el Factor R
puede ser hallado mediante el uso de datos de precipitacién anual, del mes mas lluvioso o la

maxima diaria, utilizando las siguientes férmulas.

R=a(P,/P)?

Donde:

P, = Precipitacion del mes mas lluvioso
P = Precipitacion del afio

b = Exponente

Asi mismo, seglin Roose, citado por Ramos Taipe (2001), el Factor R se obtiene mediante

la siguiente férmula.
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R=173x05%xP

Donde:
R = Factor de erosividad de la lluvia (MJ.mm/ha.h.afio)

P = Precipitacion media anual (mm)

De acuerdo con Morgan, citado por Ramos Taipe (2001), en el caso de zonas que presentan

altas precipitaciones, este indice se determina por la siguiente ecuacion.

R = I3(9.28P — 8,383)/1000

Donde:
130 = 75 mm/h (valor recomendado por Wischmeier)

P = Precipitacion media anual (mm)

Por ultimo, este factor se puede hallar mediante la ecuacion de Foster, citado por Ramos
Taipe (2001).

R = 0.276P X I5,/100

La eleccién de la ecuacidn a utilizar dependera de la data de precipitaciones con la que se
cuente. Ademas, Ramos Taipe (2001) sefial6 que las férmulas de Roose, Morgan y Foster

son las méas recomendables, debido a que se pueden adaptar facilmente.

2.13.2. Factor de Susceptibilidad a erosion del Suelo (K)

El Factor K representa la medida de la susceptibilidad a la erosion del suelo causado por
precipitaciones y escorrentia. La textura, estructura, materia organica y permeabilidad del
suelo son factores que influyen en el valor de “K”, sin embargo, la textura es la propiedad

que tiene mayor impacto en este factor (Stone y Hilborn, citado por Chadli 2016).

Un método para hallar este factor es mediante la ecuacion de Wischmeier y Smith en 1978,
la cual requiere de los datos de textura, estructura, permeabilidad y materia organica de los

tipos de suelos que existan en la zona de estudio.
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100K = 2.AM**(107*)(12 — a) + 3.25(b — 2) + 2.5(c — 3)

Donde:

M = (% limo + % arena muy fina) * (% limo + % arena - % arena fina)
a = Porcentaje de materia organica

b = Parametro de tipo de estructura de suelo

¢ = Clase de permeabilidad

Por otro lado, Sharpley y Williams (1990), establecen que, para el calculo del Factor K, se
requiere solo de los datos de textura y materia orgénica y se realiza un andlisis de la capa
superior del suelo al comienzo del afio de cada simulacion que se realice y de acuerdo a los

resultados que se obtengan, se efectlan las siguientes ecuaciones.

KUSLE = fcsand X fcl—si X forgc X fhisand

Msil
fCSand = (0.2 + 0.3 X exp—0.256xm5(1_ 1.(8')0t))

Fas = (&)0.3
cl—si mc n mSilt
. (1 0.25 X orgC )
Jorge = orgC + exp[3.72 — 2.95 X orgC]
_ M
Fisana = | 1 - 0.7 % (1-155)
isan - —
— ms —5.51422.9%x(1—=—=5%
(1 100) + exp[ (1-155)]

Siendo:

KusLe: Factor de Susceptibilidad a erosion del Suelo

Ms: Porcentaje de arena
Mgjit: Porcentaje de limo

M¢: Porcentaje de arcilla

orgC: Porcentaje de materia organica
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2.13.3. Factor Topografico (LS)

Los factores de longitud de la pendiente “L” y grado de inclinacion “S” expresan la
influencia de la topografia de un lugar en la erosion hidrica (Montes-Leon et al. 2011). Por
esta razon, cuando las pendientes de una region son mas largas y pronunciadas, las
probabilidades para que se produzcan erosiones son mayores (Stone y Hilborn, citado por
Chadli 2016).

De acuerdo con Desmet y Govers (1996), el calculo de los factores LS se realiza gracias a
un algoritmo de computadora vinculada a un software de SIG. De este modo, la ecuacion
originalmente desarrollada por Foster y Wischmeier en 1974, fue adaptada para que sea

ejecutada con valores de una grilla de celdas, resultando en la ecuacion de Desmet y Govers.

m+1 m+1
LS. = 5 (’11' — A (Foster y Wischmeier,
T (4 = Aoa) @213 1974)

Donde:

L = Factor de longitud de pendiente para el segmento |
S;j = Factor de pendiente para el segmento j

Aj = Distancia de la pendiente del segmento j (m)

m = Exponente del factor LS de la USLE

22.13 es la longitud de la parcela unitaria

[Aqj) + DZ](mH) —Aq ™t (Desmety Govers,

Laj = xMmDM+2(22.13)™ 1996)

Donde:

L, = Factor de longitud de pendiente para el pixel con coordenadas (i,))
Aj) = Area de captacion a la entrada de un pixel con coordenadas (i,j) (m2)
D = Tamafio de pixel (m)

m = Exponente del factor LS de la USLE

22.13 es la longitud de la parcela unitaria

x = Factor de correccion forma (x = 1 para sistemas pixeleados)
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Factor L

Este factor mide la distancia que recorre la escorrentia, desde su origen en la divisoria de las
aguas de la cuenca, hasta alcanzar una zona de sedimentacion o cauce (Wischmeier y Smith,
citado por Gonzélez del Tanago, 1991). De este modo, es que en la realidad cuando la
longitud recorrida por la escorrentia incrementa, se producen mayores pérdidas de suelo, y
es en la zona baja, donde esta pérdida aumenta, ya que la acumulacién de la escorrentia

aumenta al llegar aguas abajo (Meyer et al., citado por Gonzélez del Tanago, 1991).

Para efectuar la ecuacion de Desmet y Govers, se requiere hallar el parametro “m”. Segun la
metodologia desarrollada por Foster et al., citada por Yaguache Ordofiez et al. (2016), para

encontrar los valores de “m” del area de estudio se utiliza la siguiente ecuacion.

m = L (Foster et al. 1977)
1+p

Asi mismo, de acuerdo a McCool et al., citado por Yaguache Ordofiez et al. (2016), la

siguiente formula es aplicada para hallar “B”.

( sin @ )
g = 0.0896 (4)
[3(sin0)%8 + 0.56] (McCool et al. 1987)

Donde:

® = Pendiente del terreno

Factor S

El factor de inclinacion de pendiente se halla mediante la relacion de la pérdida de suelos en
una pendiente determinada, entre una pendiente normalizada de nueve por ciento (Zufiga
Huaco, 2017).

Segun McCool, citado por Yaguache Ordofiez et al. (2016), las siguientes ecuaciones son

utilizadas para hallar el factor topografico “S”.
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§$=10.8sin6 +0.03 s<9%
§=16.8sin6 —0.50 s=9%

(McCool et al. 1987)

Donde:
S = Factor de pendiente
® = Angulo de pendiente en grados

s = Inclinacién = tan ®

Ademéas de estas ecuaciones para el célculo del factor topogréfico, existe un método
simplificado desarrollado por la Facultad de Hidraulica e Hidrologia de la Escuela Técnica
Superior de Ingenieros de Montes de Madrid, que permite saber el valor del Factor LS

mediante las pendientes en porcentajes que se presentan en la zona de estudio.

Tabla 2: Valores de LS de acuerdo a la pendiente (Fuente: Tomado de Ramos Taipe 2001)

GRUPOS DE FACTORL.S
PENDIENTES EN %

0-3 0,3

3-12 1,5
12-18 34
18 - 24 5,6
24-30 87
30 - 60 14,6
60-70 20,2
70-100 25,2
> 100 28,5

2.13.4. Factor de Cobertura Vegetal (C)

Este factor refleja la capacidad de la cobertura vegetal para brindar proteccion al suelo, frente
al impacto de las precipitaciones y la potencia del flujo que se producen en la superficie
(Morante Vargas y Gonzales Carrasco, 2019). De esta manera, en las areas que cuenten con
una mayor cobertura vegetal, los valores de C se acercaran a cero, mientras que en las zonas
cuya superficie se encuentra desprotegida, los valores alcanzaran el valor de uno (Montes-
Ledn et al. 2011).
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Montes-Leon et al. (2011) realiz6 una compilacion de diferentes valores de C para diferentes
tipos de cobertura, consultando una variedad de bibliografias (Anexo 1). Asi mismo,
Wischmeier, citado por Ramos Taipe (2001), establecié valores del coeficiente C, para

diversas coberturas vegetales (Anexo 2).

2.13.5. Factor de Précticas de Conservacion (P)

La eficiencia de las practicas de conservacion que se llevan a cabo en una region para
controlar la erosion se expresa mediante este factor. Algunos ejemplos de estas técnicas de
preservacion son el laboreo a nivel, el aterrazado y el cultivo en fajas alternantes (Ibafies

Asencia et al., citado por Morante Vargas y Gonzales Carrasco 2019).

De acuerdo con Ramos Taipe (2001), los valores de P dependiendo de las practicas de
conservacion obtendran ciertos valores que se observan en el Anexo 3. Sin embargo, si no
se cuenta con esta informacion o no existe la practica de estas técnicas, P obtiene el valor de

uno en la ecuacion.
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I1l. MATERIALES Y METODOS

3.1. UBICACION DE LA ZONA DE ESTUDIO

El area de estudio del presente trabajo de investigacion se desarrollo en la cuenca del rio

Huarmey, la cual est4 ubicada en la zona noroeste del Per(, dentro de la region Ancash.

La zona de estudio se encuentra entre los paralelos 9°37°16”” y 10°11°21°” de latitud sur,
entre los meridianos 77°27°20°" y 78°10°39°” longitud oeste y su altitud varia de 0 a 4950

m.s.n.m. Asi mismo, cuenta con un area de 2,245 km? y un perimetro de 267.2 km.

Politicamente, la cuenca del rio Huarmey comprende tres provincias de la region Ancash.
La provincia de Huarmey es la que abarca mayor area de la cuenca, contando con 1,375.1
km?, que significa un 61.3 por ciento del total; por otro lado, la provincia de Aija cuenta con
un area de 599.1 km?, que representa el 26.7 por ciento; y finalmente, la provincia de Recuay
abarca 270.8 km?, siendo el 12.1 por ciento del total de la cuenca.

La principal via que se utiliza para trasladarse a la cuenca, es la carretera Panamericana
Norte, la cual conecta a la ciudad de Lima con la ciudad de Huarmey. Asi mismo, esta via
conecta a la ciudad de Huarmey con las ciudades de Casma y Chimbote por el norte. Para
poder trasladarse a la parte alta de la cuenca, existe una carretera asfaltada que va desde la
ciudad de Huarmey hasta la localidad de Huamba Baja, y a partir de ahi, existe una via no

asfaltada para trasladarse a las demas provincias.
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3.2. MATERIALES Y EQUIPOS

A continuacion, se detallara la lista de materiales que se utilizaron en el presente estudio

para el desarrollo de los modelos.

Materiales:

Capa vectorial de las unidades hidrogréficas del Pert en formato shape del portal web
del ANA

02 imagenes satelitales de la mision Sentinel-2, desarrollada por el programa Copernicus
de la European Space Agency (ESA), que abarca la cuenca Huarmey en su totalidad.
Las cartas nacionales 20-g (Culebras), 20-h (Huaraz), 20-i (Recuay), 21-g (Huarmey) y
21-h (Huayllapampa), elaboradas por el Instituto Geografico Nacional (IGN) en formato
shape, que unidas contienen la informacién topografica a un intervalo de 50 m. de la
Cuenca Huarmey.

La capa vectorial del Mapa de Hidrogeologia Nacional (2016), creado por el Instituto
Geologico, Minero y Metallrgico (INGEMMET)

Datos de precipitaciones de las estaciones climaticas de Malvas, Cotaparaco, Chamana
y Huarmey del Servicio Nacional de Meteorologia e Hidrologia del Perd (SENAMHI)
Las cartas nacionales 20-g, 20-h, 20-i, 21-g y 21-h de los Mapas Geolégicos Integrados
a Escala 1:100,000, elaborados entre el 2014 y 2016 por INGEMMET.

La capa vectorial del Mapa Geomorfoldgico del Per(, desarrollado por la Direccion de
Geologia Ambiental y Riesgo Geoldgico del INGEMMET, a escala 1:250,000, entre los
afnos 2012 y 2016.

Equipos:

Camara digital

Memoria extraible

GPS

Libreta de campo

Léapices, lapiceros, regla y borrador
Bolsas para muestras de 0.5 kg.
Plumon indeleble

Lampa
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e Barreta

e EPP (Guantes de seguridad, lentes de sol, zapatillas de montafa)

e \Wincha

e Celular inteligente

e Laptop
e Impresora
Softwares:

e Sentinel Application Platform (SNAP)

e ENVISO0

e Google Earth Pro

e Microsoft Office (Word y Excel)

e ArcGIS 10.4

3.3. METODOS

El método que se realizd consistid en cinco fases segin se muestra en el siguiente grafico.

Fase Inicial o
fase de pre-
procesamiento

Recoleccion
de datos e
imdagenes

sobre la

cuenca
Huarmey

Planificacion
del trabajo de
campo

12 fase de Geo-
procesamiento

Procesamiento
de las
imagenes y

datos
recolectados

Fase de Campo

Se realizaron
visitas parala
identificacion
de la cuenca,
toma de
muestras y
validacion de
datos.

292 fase de Geo-
procesamiento

Construccion
de la Base de
Datos
Geoespaciales

Elaboracion
de los
modelos geo-
espaciales de
Inundaciones

Elaboracion de

los modelos de

Vulnerabilidad
y USLE

Fase Final o fase
de post-
procesamiento

Presentacion de
los resultados,

conclusiones y
recomendaciones

Figura 13: Esquema metodoldgico de la tesis
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3.3.1. Fase Inicial o fase de preprocesamiento

En esta primera fase, se realizo la recopilacion de datos sobre la zona de estudio, necesaria

para la elaboracion de los modelos geoespaciales.

a. Imagenes Satelitales:

Para obtener la capa de cobertura, se requirieron de imagenes satelitales actuales, razon por
lo que se utilizaron imagenes Sentinel-2 de alta resolucion (10 m.) del &rea de estudio. Es
por ello que, para obtener esta informacion de manera libre, se cred una cuenta de usuario
en el sitio web Copernicus Open Access Hub (https://scihub.copernicus.eu/dhus/#/home),
que forma parte del Programa Copernicus, desarrollado por la Unién Europea, para

descargar de forma gratuita las imagenes Sentinel-2 y (figura 14).
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Figura 14: Sitio web Copernicus Open Access Hub (Fuente: Tomado de ESA, c2014.)

Una vez que se cred la nueva cuenta de usuario, se procedio a buscar las imagenes de la
Cuenca Huarmey. Se selecciono un area rectangular que abarco la cuenca en la pagina de
inicio de Copernicus y se ingresaron en los filtros de busqueda la fecha del Gltimo afio y de
la mision Sentinel-2 (figura 15). Debido a que la busqueda de imagenes se realizo antes de
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que el producto en el Nivel-2a estuviera disponible para la zona, se hizo la descarga de la
data en el Nivel-1c, que cuenta solo con las correcciones radiométrica y geométrica pero no

con la atmosférica. Para esta investigacion se descargaron dos archivos comprimidos:

e S2A_MSIL1C_20170723T152641 _N0205_R025_T17LRK_20170723T152915

archivo que pertenece al 23 de julio del 2017
e S2A MSIL1C 20170703T152641 N0205 R025 T17LRJ 20170703T153040 archivo
que pertenece al 03 de julio del 2017

€Sa opericus Copemicus Open Access Hub

(= w %]

S X
2 E

Sensing Date v Descending
» Sensing period

20170301

» Ingestion period . -
Periodo de fecha en la

que se tomo la imagen

O  Mission: Sentinel-1

Satellite Platform Product Type

Polarisation Sensor Mode

Relative Orbit Number (from 1 to Collection )
175) i

Area que abarca

la cuenca

Mission: Sentinel-2 mision Sentinel-2

Lat Lon: -9.93, -77.48 L. DD @ '

Figura 15: Seleccion de la cuenca Huarmey y aplicacion de los filtros de busqueda

©

Software SNAP:

Para poder realizar el procesamiento de las imagenes Sentinel-2, se requirié del programa
Sentinel Application Platform (SNAP). Segin STEP (s.f.), este software de libre acceso fue
desarrollado por ESA vy dirigido por Brockmann Consult, Array Systems Computing y C-S,
y tiene como funcién almacenar las herramientas para procesar las imagenes Sentinel. SNAP
fue descargado de la pagina web http://step.esa.int/main/download/snap-download/, que es
la Plataforma para la Aplicacion de Herramientas Cientificas, cuyas siglas en inglés son
STEP (Anexo 4). Ademas, desde esta web también se descargo el procesador Sen2Cor, en
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la direccion http://step.esa.int/main/third-party-plugins-2/sen2cor/, el cual efectud la

correccion atmosférica de las imagenes para transformar la reflectividad de techo de

atmosfera (TOA) a nivel de superficie (BOA) y de esta manera pasar el producto del Nivel-
1c al Nivel-2a (Anexo 5).

b. Informacién digital de base de datos nacional:

Para la elaboracion de la capa de pendientes de la zona de estudio, se requiri6 como
elemento principal las curvas de nivel, las cuales se obtuvieron del aplicativo de
descargas puesto a disposicion por el Ministerio de Educacion (MINEDU) a través de la
web http://sigmed.minedu.gob.pe/descargas/#. Es por medio de este servidor, que se
descargaron las cartas nacionales 20-g, 20-h, 20-i, 21-g y 21-h, que cubrieron toda el
area de la cuenca. Luego de haber descargado y descomprimido los archivos en formato

zip, se procedio a trabajar con las curvas de nivel en formato shape de cada carta.

Se requiri6 del Mapa de Hidrogeologia Nacional, creado por el Instituto Geoldgico,
Minero y Metalurgico (INGEMMET), cuya ultima actualizacion fue en el 2016. Esta
informacion se obtuvo del portal GEOCATMIN, el cual es un Sistema de Informacion
Geoldgico y Catastral Minero donde se encuentra una base de datos del territorio
nacional (INGEMMET, ¢.2017). Desde este servidor, se descargo un archivo en formato

shape del Mapa de Hidrogeologia.

Se utiliz6 el visor de estaciones que se encuentra en el portal web del ANA
(http://snirh.ana.gob.pe/visors2/), ya que contiene los datos de precipitaciones del
SENAMHI, para descargar informacion de las estaciones climéaticas de Malvas,

Cotaparaco, Chamana y Huarmey por un periodo de 21 afios (1990-2010).

Se utilizo el portal GEOCATMIN (http://geocatmin.ingemmet.gob.pe/geocatmin/) para
la descarga de los archivos en formato shape de las cartas nacionales 20-g, 20-h, 20-i,
21-g 'y 21-h de los Mapas Geoldgicos Integrados a Escala 1:100,000, elaborados entre el
2014y 2016 por INGEMMET.

37


http://step.esa.int/main/third-party-plugins-2/sen2cor/
http://snirh.ana.gob.pe/visors2/
http://geocatmin.ingemmet.gob.pe/geocatmin/

e Se obtuvo el Mapa Geomorfolégico del Per, desarrollado por el INGEMMET, mediante
el portal GEOCATMIN, donde se descargd un archivo en formato shape del mapa
completo.

c. Coordinacidn para visita de campo:

Se concertaron reuniones con el director de la Agencia Agraria de Huarmey, el Ing. Efrain
Tito Motta Padilla, para explicarle el proyecto de tesis y elaborar el plan de visita a la cuenca.

3.3.2. 1" fase de Geoprocesamiento
En esta etapa se realiz6 el procesamiento de las iméagenes e informacion digital de la cuenca
Huarmey para la elaboracién de la informacion tematica de cobertura, pendiente, capacidad
de infiltracion, geologia, geomorfologia, factor forma y precipitacion.

a. Cobertura Vegetal

Delimitacion de la imagen satelital

En este mapa tematico se podré visualizar la clasificacion de uso de suelo, y la cobertura
vegetal, que representa las formaciones naturales que estan sobre la superficie. Debido a que
este mapa puede ser utilizado para diferentes propdsitos, no existe una clasificacion
estandarizada, por lo que para cada estudio se llevara a cabo una distribucion acorde a las
necesidades (Anderson et al. 1976).

Una vez efectuada la descarga de las imagenes satelitales Sentinel-2, se procedio a ejecutar
la correccion atmosférica para que pasen del Nivel-1c al Nivel-2a, por lo cual se utilizo el
programa SNAP vy la herramienta Sen2Cor. Las dos imagenes descargadas (la primera del
23 de julio del 2017 y la segunda del 03 de julio del 2017) fueron descomprimidas y dentro
de la carpeta se encontraron diferentes archivos (Anexo 6). El archivo de metadatos,
MTD_MSIL1C en formato XML, de cada producto se abrié en el programa SNAP, ya que

dentro de ellos se encontraban las 13 bandas espectrales (figura 16).
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Figura 16: Archivos abiertos en SNAP

Después se procedio a usar el procesador Sen2Cor, que efectu6 la correccion atmosférica
para alcanzar el Nivel-2a, en esta ventana se selecciond el primer archivo y en la seccién de
Pardmetros para Procesamiento se escogio la resolucion en la que se quiso obtener el
resultado, que en este estudio fue de 10 m., con el fin de conseguir una imagen de alta
resolucion que permita una mejor clasificacion de clases (Anexo 7). Una vez terminado el
proceso de correccion, las iméagenes logradas en el Nivel-2a (figura 17) se guardaron en la
misma carpeta donde se encontraban los archivos originales. Este proceso se repite para el

segundo archivo.
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[ (2] Sentinel 2 MSI Natural Colors RGB X v o (3] Sentinel 2 MSI Natural Colors RGB X vt

Figura 17: Imagen corregida

Las bandas 2, 3, 4 y 8 que cuentan con una resolucion de 10 m. fueron las que se utilizaron
para los pasos siguiente; sin embargo, las demas bandas que cuentan con una resolucion de
20 m. y 60 m., también pueden emplearse, luego de pasar por un proceso de remuestreo
gracias a la opcion Resampling que ofrece SNAP, donde se puede cambiar la resolucion de

estas bandas a 10 m.

Después de los procesos anteriores, se efectud el mosaico de las dos imagenes que cubren la
cuenca Huarmey ya en el Nivel-2a. Ambos archivos de metadatos (MTD_MSIL2A) fueron
exportados en el formato original de SNAP, BEAM-DIMAP, que permite que el
procesamiento no tarde demasiado por no contar con memoria suficiente en el ordenador
(Casella et al. 2018). Estos nuevos archivos, se abrieron en SNAP y se selecciono la

operacion Mosaicing.
En la primera pestafia de la ventana de Mosaicing, se ingresaron los datos de entrada, los

cuales fueron las dos imagenes a unir; y los pardmetros de salida fueron, la ruta del archivo

resultante, el nombre, y el formato.
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En la pestafia de Map Projection Definition, se escogié la opcion de UTM/WGS 84
(automatico), se indicd que el tamafio del pixel resultante fuera de 10 m. y en el mapa

mundial que se muestra, se encerrd en un recuadro los limites donde se encuentra el mosaico.

Por ultimo, en la tercera pestafia de Variables y Condiciones se afiadieron las bandas a
mostrarse en el producto final, que en este caso fueron las bandas 2, 3, 4 y 8, para finalmente

correr el procesamiento con el comando Run (Anexo 8).

Figura 18: Mosaico final

Una vez que se contd con el mosaico final (figura 18), se procedio con la extraccion de la
cuenca Huarmey, razén por la que se importé al SNAP el archivo en formato shape de la
cuenca, apareciendo como una mascara sobre el mosaico. Luego, se abrid la ventana de
Land/Sea Mask cuya funcion es igualar a cero el valor de los pixeles fuera de la region de
interés (ROI), que en este caso fue el poligono de la cuenca. En la primera pestafia se
ingresaron los datos de entrada/salida y en la segunda se seleccionaron las bandas que
conformaron la imagen resultante (2, 3, 4 y 8) y el vector que se usé como mascara (Anexo
9). Finalmente se corrio el procesamiento dando como producto la imagen satelital
delimitada (figura 19). Este archivo final se exportd en formato ENVI, para que en ese

software pueda ser clasificado, esto a causa de que el ordenador donde se realizé este estudio
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no tuvo la capacidad para procesar las clasificaciones supervisadas y no supervisadas en el

programa SNAP.

Cuen! Yy g irmey en
en Infrarrojo (8,4,3) color natural (4,3,2)

Figura 19: Imagen Satelital de la cuenca Huarmey delimitada

Clasificacion No Supervisada vy Supervisada

Después de obtener la imagen satelital delimitada de la cuenca del rio Huarmey, se hizo uso
del software ENVI para la clasificacion de coberturas. En este programa se realizaron dos

tipos de clasificacion, la supervisada y no supervisada.

Durante este proceso, se encuentran zonas con caracteristicas similares para que sean
agrupadas en clases, de este modo, se inici6 con una clasificacién no supervisada K-Means
0 K-Medias, que realizd este procedimiento de manera automatica, solo necesitando los
datos de la imagen de entrada, los nimeros de clases y el nombre del archivo de salida,

resultando en la imagen de la figura 77.
Después, se llevo a cabo la clasificacion supervisada que, a diferencia de la no supervisada,

realiza una agrupacion de forma controlada. Para ello, se utilizaron imégenes de Google
Earth, y la imagen satelital delimitada en infrarrojo (para localizar las areas verdes).
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La clasificacion supervisada comienza con la definicion de los ROI’s o también llamados
regiones de interés, para lo cual se abrid la herramienta ROl y se dibujaron los poligonos de
cada zona en laimagen, los cuales resultaron en 11 clases (Anexo 10). Una vez que se obtuvo
el archivo de clases, se probd con diferentes métodos de clasificacion supervisada que cuenta
el programa ENVI, siendo la clasificacion por Méaxima Probabilidad (Maximum Likelihood),

por la que se optd en este estudio, y la cual generd el gréfico de la figura 78.

Luego de realizar la clasificacion supervisada por Maxima Probabilidad, se observo en la
imagen resultante que adn existian algunos errores en la distribucion de las zonas. Debido a
esto, se efectuaron algunas correcciones, con el fin de obtener una mayor precision en el
mapa de cobertura. Para ello, se utiliz el TIN elaborado para este estudio y se realizaron
visitas de campo a la zona urbana, agricola, llanuras, entre otras de la cuenca Huarmey, para
poder fotografiar las diferentes coberturas encontradas, asi como para tomar las coordenadas
mediante un GPS, para asignar la ubicacion de los lugares en donde se tomaron las
fotografias (figura 20, 21, 22, 23, 24y 25). Por otro lado, en las &reas que fueron inaccesibles,
debido a la falta de carreteras, se emplearon las imagenes satelitales provistas por Google
Earth Pro (figura 26).

Figura 20: Llanura arenosa
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Figura 21: Areas agricolas

Figura 22: Matorrales
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Figura 23: Montafias

Figura 24: Suelo desnudo
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Figura 26: Cuenca Huarmey en Google Earth Pro (Fuente: Tomado de Google, c2019.)
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b. Pendiente

Se utilizé el componente ArcMap del software ArcGIS, como medio para trabajar con los
archivos descargados de las cartas nacionales. Se inici6 agregando las curvas de nivel de
todas las cartas al ArcMap, sin embargo, en este caso se observo que la cuenca se encontraba
dentro de las zonas 17 y 18 sur en la proyeccion UTM. Para continuar con los siguientes
procesos, se necesitaba trabajar en un sistema definido de coordenadas, para lo cual se eligié
la zona 18 sur, ya que la mayor parte de la cuenca recae en esta area (figura 27). Una vez
realizado este analisis, se hizo el cambio de sistema de coordenadas de las cartas 20-g y 21-
g de la zona 17 sur, con la herramienta Project de ArcGIS, cuya ruta es ArcToolbox > Data
Management Tools > Projections and Transformations > Project. En esta ventana se
agrego el archivo en formato shape de la carta a transformar, el programa por defecto detectd
el sistema en el que se encontraba; luego se agregd la ubicacién del resultado, se seleccion6
el nuevo sistema de coordenadas, que en este caso fue WGS 1984 UTM Zona 18S, y se

corrid el programa. EI mismo proceso se realizo para la segunda carta.

| |

Zona 17 Sur Zona 18 Sur

Figura 27: Zonas en la que recae la cuenca Huarmey
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Antes de seguir con los siguientes pasos, se definieron las propiedades del Marco de Datos
(Data Frame Properties) de ArcMap, que luego del andlisis previo, se definid la zona 18 Sur
como el sistema de coordenadas. Después de esto, el siguiente paso fue combinar las cinco
capas vectoriales de las curvas de nivel con la herramienta Fusionar (Merge), ubicado en la
opcion de Geoprocesamientos (Geoprocessing) de la barra de herramientas. En esta ventana
se agregaron las cinco capas de las curvas de nivel y se afiadié la ubicacion del archivo de
salida. Luego de conseguir el resultado, se procedio a cortar las curvas en forma de un
poligono que encerraba el area de la cuenca, esto con ayuda de la herramienta Recortar
(Clip), que también se encuentra en Geoprocessing. La razon por la cual no se cortaron las
lineas de las curvas de nivel con la forma de la cuenca de estudio, fue porque los bordes
irregulares de este poligono generaron imprecisiones en la creacién de las redes irregulares
de triangulos (TIN).

La elaboracion del TIN se llevé a cabo con la herramienta Crear TIN (Create TIN), cuya
direccion es ArcToolbox > 3D Analyst Tools > Data Management > TIN > Create TIN.
En esta ventana se afiadid la capa de las curvas delimitadas, se escogio el sistema de
coordenadas del TIN, zona 18 Sur, luego se ingreso la ubicacion del producto de salida 'y en
las caracteristicas del archivo de entrada se seleccioné el campo donde se encontraban las
alturas de las curvas de nivel en la Tabla de Atributos, que en el caso de las cartas del IGN
es el campo “Z” (figura 28). El resultado muestra la forma del relieve de la cuenca Huarmey

y se puede observar en la figura 29.
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Figura 28: Ventana para crear el TIN
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Figura 29: TIN resultante
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Después, se efectud una interpolacion del TIN obtenido, para generar un Modelo Digital de
Elevaciones (DEM), con la herramienta TIN a Raster, que se encontré en la ruta ArcToolbox
> 3D Analyst Tools > Conversion > From TIN > TIN to Raster. Como datos de entrada,
se afiadio el TIN y se especificd que el tamafio de celda fuera de 30 m. (este tamafio fue
utilizado en todos los raster del proyecto). Como dato de salida, se agregd la ruta de salida
del DEM (figura 30). El resultado fue un réster que representa la superficie del suelo (figura
31). Ya que el DEM se elabord de forma correcta, en este punto se delimité el DEM con la
forma de la cuenca Huarmey con ayuda de la herramienta Extraer por Méascara (Extract by
Mask), el cual tiene la ruta ArcToolbox > Spatial Analyst Tools > Extraction > Extract
by Mask, en esta ventana se agrego el raster resultante, el poligono de la cuenca en formato
shape y la ubicacion que se dio al DEM de Huarmey (figura 32).

A, TIN to Raster — < cToolbox
ArcToolbox
= @ 3D Analyst Tools

TIN de la cuenca

Qutput Raster

Sampling Distance
(optional)

hAN =]

IC:\Users\L\zbeﬂ\\Desktop\PENDIENTE\dem UblcaCIon de' DEM 2

The sampling method
and distance used to

Output Data Type (optional)

define the cell size of

[ FLoat
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Figura 30: Ventana TIN a Réster
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Figura 31: Primer DEM resultante

dem_HY

Value
High : 4950

Low: 25

Figura 32: DEM de la cuenca Huarmey
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Los sumideros son errores comunes que puede presentar un DEM, es por esta razon que,
como solucion ante este posible escenario, se aplicd la funcion Rellenar (Fill), que se
encontré en la ruta ArcToolbox > Spatial Analyst Tools > Hydrology > Fill. Este nuevo
raster corregido se utilizd para hallar las pendientes de la superficie, para lo cual se empled
la herramienta Pendiente (Slope), localizada en la direccion ArcToolbox > Spatial Analyst
Tools > Surface > Slope. Para el presente estudio, se necesitd un mapa de pendientes con
las unidades de medidas en porcentaje, por lo cual en la ventana Slope se ingresaron los datos
del réster corregido, la ruta de salida y se especifico la unidad de medida en porcentaje
(figura 33).
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1
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£ Viewshed
wshed 2
<

g " 1'% Spatial Statistics Tools
oK ’ Cancel Environments... Show Help >> L) Tracking Analyst Tools

Figura 33: Ventana de la herramienta Slope

c. Capacidad de Infiltracion

Luego de haber descargado el Mapa de Hidrogeologia Nacional del INGEMMET en formato
shape, se procedié a utilizar la herramienta Clip de la opcién Geoprocessing, en el programa
ArcGIS, para delimitar los datos a la cuenca hidrogréafica en estudio. Una vez que se obtuvo
la capa de capacidad de infiltracion delimitada, se realizo una comparacion con los Mapas
Geologicos Integrados y el TIN de la cuenca, donde se mostraba que algunas areas de los
tipos de suelo requerian modificaciones en su delimitacion, razon por la cual se procedi6 a
efectuar estas correcciones. Esta nueva capa corregida contd con una tabla de atributos que
indicaba el tipo de permeabilidad que existia en los grupos de suelo de la zona de estudio.

Segun el nivel de la capacidad de infiltracion, se clasificaron los tipos de suelo en los grupos
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A, By C; donde A representa el mayor nivel de infiltracion, B el nivel medio de infiltracion

y C la més baja.

d. Geologia

Una vez que se descargaron las cartas nacionales 20-g, 20-h, 20-i, 21-g y 21-h de los Mapas
Geologicos Integrados en formato shape del portal GEOCATMIN, se procedio con el
cambio del sistema de coordenadas de las cartas que se encontraban en la zona 17 sur de la
proyeccion UTM, a la zona 18 sur, como se realizd para las curvas de nivel. Luego, estas
cartas fueron fusionadas con la opcion Merge de Geoprocessing y después se utilizo la
herramienta Clip para delimitar los datos a la cuenca Huarmey. Finalmente, con la funcién
Dissolve se simplificaron los datos de la capa de geologia, que resultd en ocho unidades

geoldgicas.

Unidades Geologicas de la Cuenca Huarmey

— Batolito de la Costa:

Esta conformado por una masa de rocas igneas de tipo pluténicas, compuesto por dioritas,
tonalitas, gabros, granodioritas y monzogranitos. Forma parte del periodo Cretacico Superior
— Paledgeno. Se presentan en forma de colinas y montafias a los lados del rio Huarmey, entre
las localidades de Tayca y Huamba, las cuales se ubican en la zona media de la cuenca.
Debido a que en estas unidades geolodgicas se pueden encontrar fracturas de gran intensidad,
son consideradas de gran riesgo, ya que son susceptibles a movimientos sismicos, asi como
a erosiones hidricas, tal y como ocurrié en marzo del 2017, donde se produjeron derrumbes

en este sector (Concha Nifio de Guzman et al. 2017).

— Depoésito Aluvial:

Estas formaciones geoldgicas, pertenece al periodo Cuaternario y estan localizadas en el
valle de la cuenca, asi como en las quebradas de esta, formando abanicos en algunas zonas.
La mayor parte de esta unidad se presenta como rocas igneas intrusivas en fracciones sub-
redondeadas, y el resto como rocas sedimentarias como calizas y areniscas. Durante el
fendmeno del Nifio Costero, estos depdsitos fueron afectados por las precipitaciones
extraordinarias, los cuales generaron movimientos de masa de agua con detritos (huaycos)

en esta zona (Concha Nifio de Guzman et al. 2017).
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— Formacion Chimu:

La edad de esta unidad es del Valanginiano inferior y ocupa un area pequefia en la parte
superior de la cuenca. Se conforma por rocas sedimentarias, tales como ortocuarcitas,
areniscas e intercalaciones de lutitas negras y capas de carbon antracitico (INGEMMET,
1995).

— Formacion Junco:

Esta unidad pertenece al Cretacico Inferior y estd compuesta principalmente por lavas
almohadilladas, y en menor proporcion por brechas sedimentarias. A pesar de que se
desarrollaron flujos de detritos en Tayca y Monsalve, esta formacidn geoldgica no presentd
derrumbes de gran magnitud durante los eventos del Fenémeno del Nifio Costero (ATDR
Casma-Huarmey, 2007; Concha Nifio de Guzman et al. 2017).

— [Formacion La Zorra:

Se encuentra ubicado en la zona costera de la cuenca Huarmey y pertenece a la edad Albiano
medio a superior. Esta unidad presenta flujos piroclasticos, asimismo una intercalacion de
rocas sedimentarias e igneas como las limolitas y andesitas, y finalmente cuenta con las rocas
sedimentarias calizas y areniscas. Se encuentra sobre la Formacion Junco y bajo la
Formacion Lupin. Durante las precipitaciones de marzo del 2017, no se produjeron mayores
cambios en esta unidad, sin embargo, los depositos cuaternarios ubicados sobre esta

formacion presentaron deslizamientos (Concha Nifio de Guzman et al. 2017).

— Formacién Lupin:
Tiene una edad del Cretaceo Superior, y aflora en la zona media y baja de la cuenca
Huarmey. Esta compuesto principalmente por lavas almohadilladas y brechas, y en menor
proporcion de tufo andesitico. Esta unidad permanecié estable cuando se presentd el
Fendmeno del Nifio Costero en 2017 (ATDR Casma-Huarmey, 2007; Concha Nifio de
Guzman et al. 2017).

— Formacion Santa, Carhuaz:
Estas formaciones integran el Grupo Goyllarisquizga. La Formacién Santa forma parte del

periodo Valanginiano medio a superior y esta compuesta por rocas sedimentarias, tales como
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las calizas y lutitas calcareas abigarradas, de igual forma presenta calizas negras, margas y
lutitas oscuras. Por otro lado, la Formacion Carhuaz sobreyace la Formacion Santa y tiene
una edad de Valanginiano superior. En la parte inferior de esta formacidn existe una
composicion donde predomina la arcilla y estd compuesta por intercalaciones de rocas
sedimentarias como las lutitas fosiliferas con areniscas, calizas y yeso. Asi mismo, la parte
superior se caracteriza por el color pardo rojizo de las areniscas y presenta lutitas y lutitas
arenosas (INGEMMET, 1995).

— Grupo Calipuy

Ubicado en la parte superior de la cuenca Huarmey, abarcando la Cordillera Negra de
Ancash. Forma parte del periodo tardio del Terciario Inferior. Esta unidad también llamada
Volcénico Calipuy esta compuesta principalmente por lavas andesiticas, toba volcénica,
piroclastos, aglomerados y lavas &cidas, asi también de cuerpos intrusitos subvolcanico. Esta
unidad no presentd alteraciones durante las precipitaciones en marzo del 2017 (ATDR

Casma-Huarmey, 2007; Concha Nifio de Guzman et al. 2017).

e. Geomorfologia
El archivo shape del Mapa Geomorfoldgico del Perl se agregd al marco da datos (Data
Frame) de ArcMap para que sea recortado con la herramienta Clip de la opcién
Geoprocessing, de acuerdo al area de estudio. A la capa resultante, se le aplicé la funcion

Dissolve, y esto dio como resultado cinco unidades geomorfoldgicas.

Unidades Geomorfoldgicas de la Cuenca Huarmey

— Colinas y lomadas

Se localizan en la parte media baja de la cuenca, a ambos lados del valle, con elevaciones
gue van de 50 a 300 m. y pendientes suaves. Asi mismo, presentan cumbres y laderas
redondeadas. Esta unidad presenta rocas intrusivas, volcanicas y sedimentarias, las cuales
pueden ser vulnerables a movimientos en masa, deslizamientos o derrumbes, dependiendo
de su composicidn, grado de fracturamiento y exposicion ante efectos climaticos (erosion o

meteorizacion) (Zavala et al. 2009).
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— Mantos de arena

Se originan por la migracién y acumulacion de arena debido a procesos edlicos y la
geomorfologia de la zona, y pueden presentar formas alargadas, onduladas o de dunas. En
la cuenca de estudio, los mantos se encuentran adyacentes a las colinas (Zavala et al. 2009).

— Montafia con pendientes suaves a moderadas

Se encuentra distribuida a lo largo de la cuenca, con pendientes de 15° a 29°, y estan
localizadas adyacente a montafias estructurales de laderas escarpadas. El relieve de las
montafas esta relacionado con la formacién de carcavas, derrumbes y huaycos. Las rocas
intrusivas que se presentan en esta unidad pueden ser vulnerables a movimientos de masa
(Zavala et al. 2009).

— Montafia con pendientes moderadas a fuertes

En esta unidad existen laderas que van de moderadas a fuertes, no menores a 30° y llegando
asuperar los 70°. Se localizan a partir de la parte media a la parte alta de la cuenca y presenta
rocas intrusivas, sedimentarias y volcano-sedimentarias. En esta zona existe la posibilidad

de caidas de rocas, deslizamientos, derrumbes y avalanchas de detritos (Zavala et al. 2009).

— Terraza aluvial

Esta unidad esta ubicada sobre el cauce y la zona de inundacion fluvial, y esta rodeada por
los valles de la cuenca. Esta unidad presenta una superficie plana, con pendientes de 1° a 5°,
y depdsitos aluviales en forma de terrazas. Es susceptible a inundaciones periddicas, asi

como erosion y derrumbes en los margenes (Zavala et al. 2009).

f. Factor Forma

Sen (2008) indic6 que el factor forma presenta una relacion con la cantidad de escorrentia
que se da en la cuenca, al igual que con la formacion de inundaciones. Asi mismo, en el caso
de que existan dos cuencas con una misma area, la cuenca con forma mas alargada tendra
un caudal maximo menor, que la cuenca con una forma mas redonda. Debido a lo explicado,
es que se requirio de esta capa y para ello se utilizo la formula de factor forma propuesto por

Horton.
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Donde:

Ks: Factor forma

A: Area de la cuenca (km?)

L: Longitud de la cuenca (km)

El procedimiento comenzo con la delimitacion de las subcuencas de la zona de estudio. Para

esto, se requirié del DEM corregido con la herramienta Fill, elaborado previamente para el

mapa de pendientes y de las herramientas de Hidrologia (Hydrology) del software ArcGIS.

Como primer paso, se utiliz6 el raster “Fill Hy”, para hallar la direccion de flujo de cada

celda con la opcion Flow Direction, que se encontrd en la ruta ArcToolbox > Spatial

Analyst Tools > Hydrology > Flow Direction, donde se ingresé el archivo “Fill Hy” y la

direccion del archivo de salida (figura 34). El raster generado, “Flow_Dir”, se observa en la

figura 35.
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Figura 34: Ventana de Flow Direction
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Figura 35: Réster de Flow Direction

Luego, se hallaron las acumulaciones de flujo de cada celda con la funcién Flow
Accumulation (figura 36), localizado en la ruta ArcToolbox > Spatial Analyst Tools >
Hydrology > Flow Accumulation, en esta ventana se ingresaron el raster de direccion de
flujo y el nombre del archivo resultante, que fue “Flow Acc” (figura 37). El réaster que se

obtuvo se muestra en la figura 38.

Flow direction Flow accumulation

Figura 36: Determinacion de acumulacion de flujo (Fuente: Tomado de ESRI s.f.)
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A continuacion, se procedid con la identificacion de las redes de drenaje, que se realizo
mediante la Calculadora de Réster (Raster Calculator), cuya funcion fue determinar la red
de flujo utilizando una expresion condicional, donde las celdas que tuvieron una
acumulacién de flujo con valores mayores a 20,000 (valor adecuado para este estudio),
equivalieron a uno y el resto de celdas que no cumplian con esta condicion, se dio un valor
de cero (figura 39). Esta herramienta se encontrd en la direccién ArcToolbox > Spatial

Analyst Tools > Map Algebra > Raster Calculator. El presente calculo dio como resultado
el raster de la figura 40.

“, Raster Calculator — (m] X B @ Spatial Analyst Tools
® & Conditional
Map Algebra ex Rister de & & Density
e acumulacién de flujo Conditi = & & Distance
onditional & & Extraction
B .| 0 @ & Generalization
Fick ® & Groundwater
S| (V)] | Sethul @ & Hydrology
Math # & Interpolation
<=|l ~ || Abs #* & Local
Expresion de . Exp = & Map Algebra
condicional = = | a1 Exp10 N * Raster Calculator
Con(("flove_acc™) > 20000,1) BRSIRERE ERNE el g | Herréﬁ';i(;nta
20000, equivalea 1
e Raster Calculator
+ IV ay
Output raste
d @ & Raster Creation
| C:\Users\Lizbeth\Desktop\Factor Formalstream_20000 [é] i Rotions
Archivo resultante V| @ & Segmentation and (
< > & & Solar Radiation
&+ & Surface
OK Cancel Environments... ~ Show Help >> # & Zonal
@ Snatial Statictice Toole

Figura 39: Ventana de Raster Calculator
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Figura 40: Raster de Red de drenaje de la cuenca Huarmey

Después, las redes de drenaje fueron transformadas de un formato raster a un formato shape,
para lo cual se us6 la herramienta De Corriente a Entidad (Stream to Feature), que se
encontrd en la ruta ArcToolbox > Spatial Analyst Tools > Hydrology > Stream To
Feature. En esta ventana se afiadieron los datos del raster de redes de drenaje, calculados
anteriormente; el raster de direccion de flujo y la ubicacion del shape de salida (figura 41).

El archivo de polilinea de las redes de drenajes se puede ver en la figura 42.
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Figura 41: Ventana de Stream To Feature

Figura 42: Shape de red de drenaje
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Este archivo de polilinea de los arroyos sirvié para hallar los puntos de desfogue de las

subcuencas de la zona de estudio. Por medio de la funcion De Vértices de Entidad a Puntos

(Feature Vertices To Points), ubicado en ArcToolbox > Data Management Tools >

Features > Feature Vertices To Points, se transformaron los vértices donde terminan las

redes, en un nuevo archivo de puntos que representan los puntos de salida de las subcuencas.

Para ello, se requirio del shape de red de drenaje, llamado “StreamToFea20000”, la ruta de

salida de los puntos y la seleccién del tipo de veértice que generaran los puntos, que en este

caso es el vértice final (figura 43). El resultado se puede ver en la figura 44.
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Figura 44: Puntos de desfogue

Como siguiente paso, se procedio con la delimitacion de las subcuencas de la zona de
estudio, para lo cual se utilizé la herramienta Cuenca Hidrografica (Watershed), cuya ruta
es ArcToolbox > Spatial Analyst Tools > Hydrology > Watershed. Para ejecutar esta
funcion, se afiadieron el raster de direccién de flujo, el archivo de los puntos de desfogue y
la ubicacion del archivo de salida (figura 45). Las subcuencas delimitadas se muestran en la

figura 46.
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Finalmente, se hallo el pardmetro de factor forma para cada subcuenca. Para realizar este
calculo, se tuvo que convertir el raster de subcuencas en un archivo de formato shape (figura
47), con el fin de determinar las longitudes y areas de las cuencas. Las longitudes (del punto
de desfogue al punto més lejano de la linea divisoria de aguas), se hallaron con la herramienta
Medir (Measure) de ArcGIS, y las areas, con la funcion Calcular Geometria (Calculate
Geometry), ubicado en la Tabla de Atributos del archivo shape; ambos datos se calcularon

en km y km?, respectivamente.

Figura 47: Shape de las subcuencas de Huarmey

Luego, el factor forma de cada unidad hidrografica se encontrd con la funcién Calculadora
de Campo (Field Calculator), donde se ingresé la division del area entre la longitud al
cuadrado (figura 48). A los valores resultantes de las subcuencas, se les asignaron la forma

correspondiente de acuerdo a la Tabla 3.
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Tabla 3: Forma de la cuenca segun los valores de Factor Forma (Fuente: Tomado de

Pérez, citado por Cordova 2016)

Factor de forma (valores aproximados)

Forma de la cuenca

<0.22 Muy alargada
0.22a0.30 Alargada
0.30a0.37 Ligeramente alargada
0.37a0.45 Ni alargada ni ensanchada
0.45a 0.60 Ligeramente ensanchada
0.60a0.80 Ensanchada
0.80a1.20 Muy ensanchada
>1.20 Rodeando el desagie
Table O x
=LY
FACTOR_FORMA_20K
FID Shape GRIDCODE AREA_KM2 LONG_KM Factor Forma Forma Cuenca
4 |Paolygon 14 72.865625 16.985317 0.252566 |Alargada
12 [Palygon 28 49.894335 13.360405 0.279519 |Alargada
17 [Palygon 38 186.287208 28.366702 0.231508 |Alargada
11[Palygon 23 86.666077 11.49516 0.655872 |Ensanchada
21|Polygon 30 80.875711 10.653516 0.712578 |Ensanchada
1|Polygon 4 43 742606 11.189606 0.349362 |Ligeramente Alargada
5|Paolygon 18 25.903606 8.36624 0.370083 |Ligeramente Alargada
14 |Palygon 25 170129478 22.310872 0.34178 |Ligeramente Alargada
23|Polygon 47 116.801029 19.66073 0.302167 |Ligeramente Alargada
26 |Polygon 58 27.055137 9 258964 0.315591 |Ligeramente Alargada
9|Paolygon 17 40.146806 8.716095 0.528454 |Ligeramente Ensanchada
13|Paolygon 3 35.056916 §.119219 0.531796 |Ligeramente Ensanchada
18 |Polygon 45 19.796791 5949537 0.559279 |Ligeramente Ensanchada
24 |Palygon 41 22129653 6.14162 0.58669 [Ligeramente Ensanchada
25|Polygon 40 83.040753 11.814847 0.594888 |Ligeramente Ensanchada
29|Polygon 55 93.981835 12 501087 0.601379 |Ligeramente Ensanchada
31|Polygon 61 57 522406 10879121 0.486015 |Ligeramente Ensanchada
32|Palygon 63 98.392019 14632648 0.45953 |Ligeramente Ensanchada
22|Polygon 51 29.777438 12.076584 0.204173 |Muy Alargada
27|Polygon 56 126.213498 24 454505 0.210879 |Muy Alargada
28|Palygon 44 33.035305 12.773216 0.202478 |Muy Alargada
0|Paolygon 1 71.408876 8.972426 0.887018 [Muy Ensanchada
2|Palygon 3 106.826673 11.424522 0.818472 |Muy Ensanchada
3|Polygon 7 9.343584 2 B56ETT 1.144962 |Muy Ensanchada
8 |Palygaon 13 64.34744 6.669874 1.446425 Muy Ensanchada
10|Polygon 21 86.864379 9.610781 0.962078 Muy Ensanchada
16 |Polygon 36 71215387 5.080595 1.090654 |Muy Ensanchada
7 |Polygon 1 116.796463 17.622798 0.37608 |Mi Alargada Ni Ensanchada
15|Paolygon 33 117.816991 17.371851 0.390405 |Mi Alargada Ni Ensanchada
20|Paolygon 49 12722997 5. 488383 0.422377 |Mi Alargada Ni Ensanchada
6 |Polygon 9 43 736361 2 963956 4978507 |Rodeando el desagiie
19|Palygon 26 23.447348 1.933718 6.270576 |Rodeando el desagie
30|Palygon 60 19.150252 2.63587 2.7563 |Rodeando el desagiie
o 0 » » [E]= (0outof 33 Selected)

| FACTOR_FORMA_20K

Figura 48: Resultados en la tabla de atributos
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g. Precipitacion

El Mapa de Precipitaciones se desarrollé gracias a los datos de SENAMHI. Las estaciones
climaticas de Malvas, Cotaparaco, Chamana y Huarmey fueron las que se utilizaron, y el
periodo de tiempo en que los datos fueron recolectados fue de 21 afios (1990-2010). Estos
valores fueron ordenados en una hoja Excel, sin embargo, debido a la falta de data de
precipitaciones (PP) que se presentaron en algunos meses de las estaciones, se utilizé el

método de Regresion Lineal para completar la informacion faltante (Tabla 4).

Tabla 4: Datos completos por método de Regresion Lineal

PP de Estaciones (mm) PP media

ANO — ¢ anual

MALVAS COTAPARACO CHAMANA HUARMEY  (mm)
1990 233.80 269.70 46.30 1.28 137.77
1991 370.20 229.00 28.00 0.78 156.99
1992 238.30 142.70 30.10 0.83 102.98
1993 551.70 718.86 219.40 6.08 374.01
1994 518.80 337.50 100.90 2.80 240.00
1995 251.80 278.80 60.00 1.66 148.07
1996 393.80 366.00 105.60 2.93 217.08
1997 550.40 398.00 124.60 3.45 269.11
1998 862.50 671.70 339.70 9.42 470.83
1999 664.70 500.64 219.80 6.09 347.81
2000 567.10 486.20 128.54 2.70 296.14
2001 559.10 498.70 144.74 1.60 301.03
2002 517.44 455.30 103.90 1.00 269.41
2003 324.50 349.80 79.31 11.20 191.20
2004 343.80 259.86 52.70 1.46 164.45
2005 278.77 202.50 27.30 1.70 127.57
2006 510.40 407.47 74.50 0.20 248.14
2007 402.90 347.10 90.21 3.00 210.80
2008 562.80 410.60 119.38 0.90 273.42
2009 614.10 523.10 147.91 4.10 322.30
2010 333.50 405.37 115.77 2.20 214.21
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Luego, con el fin de determinar si es que existen inconsistencias en los datos estimados, se
realiz6 un analisis de curva de doble masa entre los valores acumulados de las
precipitaciones anuales, con los promedios acumulados (Tabla 5). Esta comparacion de
datos, genero lineas rectas consistentes, las cuales indicaron una proporcionalidad entre los
datos (figura 49). Sin embargo, en caso hubiera surgido inconsistencias en alguna estacion,

esta se habria eliminado.

Tabla 5: PP acumuladas

> PP acumuladas de Estaciones (mm) PP media
ANO —  acumulada
MALVAS | COTAPARACO CHAMANA HUARMEY (mm)
1990 233.80 269.70 46.30 1.28 137.77
1991 604.00 498.70 74.30 2.06 294.77
1992 842.30 641.40 104.40 2.89 397.75
1993 1394.00 1360.26 323.80 8.98 771.76
1994 1912.80 1697.76 424.70 11.78 1011.76
1995 2164.60 1976.56 484.70 13.44 1159.82
1996 2558.40 2342.56 590.30 16.37 1376.91
1997 3108.80 2740.56 714.90 19.82 1646.02
1998 3971.30 3412.26 1054.60 29.24 2116.85
1999 4636.00 3912.90 1274.40 35.33 2464.66
2000 5203.10 4399.10 1402.94 38.03 2760.79
2001 5762.20 4897.80 1547.68 39.63 3061.83
2002 6279.64 5353.10 1651.58 40.63 3331.24
2003 6604.14 5702.90 1730.89 51.83 3522.44
2004 6947.94 5962.75 1783.59 53.30 3686.90
2005 7226.71 6165.25 1810.89 55.00 3814.46
2006 7737.11 6572.72 1885.39 55.20 4062.61
2007 8140.01 6919.82 1975.60 58.20 4273.41
2008 8702.81 7330.42 2094.98 59.10 4546.83
2009 9316.91 7853.52 2242.89 63.20 4869.13
2010 9650.41 8258.89 2358.66 65.40 5083.34
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Figura 49: Curva de doble masa

Una vez que se comprobd la confiabilidad de los datos, se ordenaron las estaciones con la
informacidn de sus coordenadas, altura y precipitacion anual media (Tabla 6). Después, con
el fin de obtener més datos de precipitaciones en la zona de estudio, se crearon nuevos puntos
en la cuenca. Para calcular el valor en estos nuevos puntos, se hizo una comparacién entre
altura y precipitacion de las 4 estaciones (figura 50), la cual gener6 un R=0.9, que signific
la validez de esta relacion y permitid que se use la ecuacién generada para hallar las nuevas

precipitaciones, utilizando el valor de las alturas con que se cuentan.

Tabla 6: Datos completos de las estaciones

MALVAS -9.93° -77.65° 3500 459.54

COTAPARACO -9.98° -77.58° 3008 393.28

CHAMANA -10.25° -717.57° 2000 112.32
HUARMEY -10.08° -78.17° 20 3.11
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Figura 50: Relacién Altura vs. PP media
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Se agregaron 25 puntos adicionales a los 4 ya existentes. Se hallaron sus alturas gracias al

DEM elaborado previamente y ya con estos datos, se calcularon los valores de

precipitaciones con la ecuacién sefialada en la Figura 50. El resultado se puede observar en

el Tabla 7.
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Tabla 7: Puntos con los nuevos datos de precipitaciones
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Finalmente, se hizo una interpolacién de estos valores con la herramienta Spline, ubicada en
la direccion ArcToolbox > Spatial Analyst Tools > Interpolation > Spline, y en cuya
ventana se agrego el archivo shape de los puntos; se seleccion6 en el campo que contenia

los valores Z, el campo de PP media anual; se indico la ruta de salida del archivo raster y el

179982.53
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188836.05
192182.69
194407.91
196606.05
201237.23
204605.76
201094.25
205559.96
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220242.47
225013.32
217215.54
214476.02

8893552.42
8888219.06
8910669.73
8902480.13
8895870.90
8892096.84
8910289.25
8899739.37
8890127.39
8917279.25
8907675.76
8925374.29
8908837.79
8903192.42
8897388.63
8927494.26
8913795.03
8904508.96
8920250.24
8889732.90

450.98
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2162.08
1026.27
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1518.96
2350.00
3444.25
3600.00
4107.87
4408.58
4550.00
4292.46
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4313.91
4295.76
4202.29
3326.91

tamario de celda, que en este estudio fue de 30 m. (figura 51).
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Figura 51: Ventana de Spline

3.3.3. Fase de Campo

En la primera visita que se realizo, se efectud la reunion con el director de la Agencia Agraria
de Huarmey, el Ing. Efrain Motta, a quien se le explicé el tema que trataba la tesis, asi como
los objetivos que esta buscaba. Como resultado de esta primera asamblea, se traz6 un primer
recorrido por la cuenca Huarmey, para la identificacion las caracteristicas de las diferentes
zonas que la conforman. Una vez que se establecio la ruta de viaje, se procedié con el
reconocimiento de la cuenca, la zona urbana, las zonas agricolas que la conforman, las areas

montafosas, etc.

La segunda visita que se realiz6 a la cuenca Huarmey, fue luego de obtener los primeros
modelos para realizar la validacion de campo. Asi mismo, se llevo a cabo la toma de muestras
de los tipos de suelos que conformaban la cuenca, con el fin de obtener informacion de la
texturay el porcentaje de materia organica; ademas que se realizaron pruebas de infiltracion.
Para esta segunda fase, también se conto con la ayuda del Ing. Motta, ya que se requirio del
permiso de algunos propietarios, para poder ingresar a sus territorios y obtener dichas

muestras.

73



3.3.4. 2% fase de Geoprocesamiento

a. Construccion de Base de Datos Geoespaciales

La base de datos del presente estudio fue disefiada gracias al software Enterprise Architect,
con el cual se realizé el esquema logico de las variables a utilizar para los modelos de
inundaciones, vulnerabilidad y USLE, para luego construir la geodatabase en el software
ArcGIS.

FACTOR_FORMA CAPACIDAD DE
INFILTRACION
ID_Forma
Area_km2 - ID_Suelo INUNDACIONES
Perimetro - Capac_Infilt_Suelo EXTRAORDINARIAS
Longitud_km - Area_km?2
Factor_Forma - Perlmetro ID_FF
Descripcion_Forma - Calificacion_Suelo Cal?f?cac?on_(ob
Calificacion_Forma T ~ ] E:::I:E:E:Z:_i:i:
L [> - Calificacion_Forma
- Calificacion_FF
s D - Nivel_FF
- D - Area_km2
- Perimetro
= D INUNDACIONES_PP
h > ID_FLOOD_PP
D - Calificacion_Cob
( [> - Calificacion_Suelo
- Calificacion_Pend
COBERTURA PENDIENTE - Calificacion_Forma
PRECIPITACION - Calificacion_PP
ID_Cob - ID_Pend ~ calificacion_F_PP
Simbolo_Cob - Rango - ID_PP 4|> - Nivel F PP
Descripcion_Cob - Descripcion_Pend - Rango - Area km2
Area_km?2 - Area km2 - Area km2 Pl
Perimetro - Perimetro - Perimetro
Calificacion_Cob - Calificacion_Pend - Calificacion_PP

Figura 52: Esquema légico de la base de datos de los modelos de inundaciones
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PRECIPITACION
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Simbolo Cob
Descripcion_Cob
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VULNERABILIDAD_FISICA

L

EVVVV

PENDIENTE GEOLOGIA GEOMORFOLOGIA
ID_Pend ID_Geolo - ID_Geomo
Rango Simbolo - Simbolo
Descripcion_Pend Unidad_Geolo - Unidad_Geomo
Area_km2 Descripicion - Area_km2
Perimetro Area_km2 - Perimetro
Calificacion_Pend Perimetro - Calificacion_Geomo

Calificacion_Geolo

- ID_Vuln_Fisica

- Calificacion_Pend

- Calificacion_PP

- Calificacion Cob

- Calificacion_Geolo

- Calificacion_Geomo

- Calificacion_Vuln_Fisia
- Nivel Vuln_Fisica

- Area km2

- Perimetro

Figura 53: Esquema logico de la base de datos del modelo de vulnerabilidad

SUELO

ID_Geolo
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Unidad Geolo
Descripicion
Area_km?2
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|
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ID_Cob

Simbolo Cob
Descripcion_Cob
Area km2
Perimetro
Calificacion_Cob

i

Factor_C

D Factor_K

PRECIPITACION

ID_PP

Rango
Area_km?2
Perimetro
Calificacion_PP

D Factor_R

USLE_Perdida_Suelo

5

L
PENDIENTE Factor LS
ID_Pend
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Area_km2
Perimetro

Calificacion_Pend

Figura 54: Esquema logico de la base de datos del modelo USLE
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b. Elaboracion de los modelos geoespaciales de Inundaciones

De acuerdo con Wahid et al. (2016), para la generacion del Mapa de indice Potencial de
Inundaciones Extraordinarias, solo se requieren de cuatro capas tematicas, las cuales son:
factor forma, pendiente, cobertura y capacidad de infiltracion, y no se toma en cuenta la capa
de precipitaciones, ya que el estudio se basa en precipitaciones inusuales, que no se registran

normalmente en la zona.

Sin embargo, en la presente tesis se realiz6 un primer modelo, adaptado del estudio de Wahid
et al., tomando en cuenta las cuatro capas mencionadas previamente y un segundo modelo,
tomando en cuenta los datos de precipitaciones, esto con el fin de realizar una mejor

identificacion de las zonas vulnerables.

¢ Mapa de Inundaciones Extraordinarias

Para este modelo, no se tomé en cuenta la capa de precipitaciones y solo se usaron las

variables de cobertura, capacidad de infiltracion, factor forma; y el raster de pendiente.

Entonces, para iniciar con este proceso se convirtieron las tres capas vectoriales al formato
raster ya que, para hallar el mapa de inundaciones extraordinarias, se requirié de la
herramienta Superposicion Ponderada (Weighted Overlay) de ArcGIS, la cual ejecuta esta

funcién solo con archivos en formato raster.

Por lo tanto, se procedi6 con la conversion de las capas vectoriales de cobertura, capacidad
de infiltracién y factor forma, a un formato raster. Para ello se usé la herramienta Poligono
a Raster (Polygon to Raster), ubicado en la direccion ArcToolbox > Conversion Tools >
To Raster > Polygon to Raster, donde se ingresaron los archivos vectoriales, se seleccion6
el campo que se utilizé para asignar los valores del raster, se afiadieron las rutas de salida y
se indicé el tamafio de celda, que en este caso para que la superposicion funcione de forma

correcta, todas las capas tuvieron un mismo tamafio de 30 m. (figura 55).

Asi mismo, para que se efectle este mismo procedimiento en las tres capas, se utilizé la

aplicacion ModelBuilder, donde se ingresaron los datos requeridos, que se explicaron
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previamente para la conversion a un formato réster y finalmente se dio clic a la opcion correr

(Run). En la figura 56 se muestra el modelo para este procesamiento.

‘& Polygon to Raster

X

P E e Capa vectorial

TipoSuelo_HY18
Value field

Output Raster Dataset

v

Cell assignment
CELL_CENTER

‘i Ruta de salida

N\

SoilType Campo de donde se extraeran los valores del raster

| C:\Users\Lizbeth\Desktop\TESIS\METODOLOGIA\1 CAPAS PARA MODELO 1_|=1||

q

Priority field (optional)

| NONE

Cellsize (optional)

30
Tamarfio de celda
<

Herramienta
Polygon to Raster

& To CAD
& To Collada
& To Coverage
& To dBASE
& To Geodatabase
& To KML
= & To Raster

“ ASCIl to Raster

“. DEM to Raster

“ Feature to Raster

“ Float to Raster

#, LAS Dataset to Raster
“ Multipatch to Raster
“, Point to Raster
y Polygon to Raster
“ Polyline to Raster
5’ Raster To Other Format
& To Shapefile

> @ Data Interoperability Tools
| OK | ’ Cancel ‘ | Environments... ‘ | Show Help >> ‘ e Da_t? Management Tools
& Editing Tools
Figura 55: Ventana de Polygon to Raster
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Figura 56: Uso de ModelBuilder para convertir un shape a raster
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Después, con la ayuda del software ArcGIS se reclasificaron estos valores segin una escala
de 1 a 10, de los cuales los valores que tenian menor impacto en la formacion de
inundaciones fueron los cercanos al uno, mientras que los que podian originar grandes

escorrentias fueron los cercanos al 10 (Tabla 8).

Tabla 8: Pesos y niveles

Pesos Nivel
1 :
Muy Bajo
2
3 .
Bajo
4
5
Moderado
6
7
8
9
10

Gracias a esta tabla, se procedio con la reclasificacion de las cuatro capas en formato réster,
que cabe recalcar contaban con un mismo tamafo de celda y se encontraban en el mismo
sistema de coordenadas. Este proceso se realiz6 con la herramienta Reclasificar (Reclassify),
ubicado en ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify. Para este

procesamiento se utilizo la aplicacion ModelBuilder, como se muestra en la figura 57.

En la tabla 9 se muestra las categorias de cada capa, asi como los pesos y niveles otorgados
a cada rango. En esta parte del procedimiento existe una variacién con la metodologia de
Wahid et al., que se da en la clasificacion de las pendientes. Para el desarrollo de esta tesis,
a las pendientes méas pronunciadas se les asigné un menor peso y a las pendientes leves uno

mayor, ya que es en la zona llana donde las inundaciones se producen.
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Tabla 9: Primera clasificacion de los pesos y niveles de cada categoria

> 60%
40% - 60%
35% - 40%
30% - 35%
25% - 30%
20% - 25%
15% - 20%
10% - 15%

5% - 10%
<5%
Muy Alargada
Alargada
Ligeramente alargada

Ni alargada ni
ensanchada

Ligeramente ensanchada
Ensanchada
Muy ensanchada
Rodeando el desagtie
A (alta infiltracion)
B (media infiltracion)
C (baja infiltracion)
Matorrales
Agricola
Montafias
Llanura arenosa
Urbana
Laguna
Rio
Suelo desnudo

Pendiente

Factor Forma

Capacidad de

infiltracion

Cobertura
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Muy Bajo
Bajo
Moderado
Alto
Muy Alto

Muy Bajo
Bajo
Moderado

Alto

Muy Alto

Muy Bajo
Moderado
Muy Alto
Bajo
Moderado
Alto

Muy Alto
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Figura 57: Uso de ModelBuilder para reclasificar las capas

Una vez que se obtuvieron los réster con los valores definidos, se procedi6 con la
superposicién ponderada de capas, para lo cual se tomé en cuenta la Table de Ponderacion
de Valores (Tabla 10), y junto a la informacién de la Tabla 9, se ejecutd la aplicacién
ModelBuilder, donde se cred el flujo de trabajo del modelo del Mapa de Inundaciones
Extraordinarias. En el entorno del ModelBuilder se agregaron los raster y la funcion
Weighted Overlay, cuya ruta fue ArcToolbox > Spatial Analyst Tools > Overlay >

Weighted Overlay para realizar el modelamiento geoespacial de las variables (figura 58).
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Tabla 10: Primera Ponderacién de Valores

vare Sl
Pendiente 50
Factor Forma 10
Capacidad de infiltracion 30
Cobertura 10

N

Reclassify (2)

K
Reclassify (4)

“\
Weighted
Overlay

4\
Reclassify (3)

N

Reclassify

Figura 58: Uso de ModelBuilder para la integracion de variables

e Mapa de Inundaciones, considerando PP

Este segundo modelo se construyd utilizando el mismo procedimiento que el anterior, con
la Unica diferencia que a la Tabla 9, de pesos y niveles de cada capa, se agreg6 la variable
de precipitaciones, como se muestra en la Tabla 11. Asi mismo, para la ponderacion de los
valores de las capas, se utilizé la Tabla 12, donde se considera el grado de la capa de
precipitaciones.
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Tabla 11: Segunda clasificacion de los pesos y niveles de cada categoria

Pendiente

Factor Forma

Capacidad de
infiltracion

Cobertura

Precipitacién

> 60%
40% - 60%
35% - 40%
30% - 35%
25% - 30%
20% - 25%
15% - 20%
10% - 15%

5% - 10%
<5%
Muy Alargada
Alargada

Ensanchada

Muy ensanchada

Matorrales
Agricola
Montafias

Llanura arenosa
Urbana
Laguna

Rio
Suelo desnudo
0—150 mm
150 — 300 mm
300 — 450 mm
450 - 600 mm

Ligeramente alargada
Ni alargada ni ensanchada
Ligeramente ensanchada

Rodeando el desagie
A (alta infiltracion)
B (media infiltracidn)
C (baja infiltracion)
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Tabla 12: Segunda Ponderacion de Valores

Pendiente 50

Factor Forma 10
Capacidad de infiltracion 20
Cobertura 10
Precipitacion 10

c. Modelo Geoespacial de Vulnerabilidad Fisica

Asi mismo, se elabor6 un modelo para identificar las zonas vulnerables a los procesos
erosivos debido a las precipitaciones. Por lo cual, se requirieron de las variables de cobertura,
geologia, geomorfologia, pendientes y precipitaciones, para que sean intersecadas y obtener
nuevos poligonos, a los que se les aplicaron una ecuacion para obtener su nivel de
vulnerabilidad.

Se inici6 este procedimiento con la reclasificacion de los archivos raster de pendientes y
precipitaciones de acuerdo a las categorias presentadas en la Tabla 13, para después

convertirlos a capas vectoriales con la herramienta Raster to Polygon (Figura 59).

-4 Model - O

Model Edit Insert View Windows Help
S LBR X 2 S BEBEIIQAN NSV

< iy
. Pendiente_ Raster to
Reclassify Polygon

Reclassify
(2)

=3

Raslér to
Polygon (2)

Figura 59: Conversion de los raster a capas vectoriales en ModelBuilder
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Una vez que se contaron con los cinco archivos en formato shape, se utilizo la funcion
dissolve para sintetizar los datos. Luego con las cinco capas resultantes listas, en cada una
de ellas se agreg6 un campo nuevo en la Tabla de Atributos con los pesos correspondientes
segun la Tabla 13 y seguidamente se procedié con la interseccion de las capas con la

herramienta Intersect en el entorno de ModelBuilder (Figura 60).

Tabla 13: Tercera clasificacion de los pesos y niveles de cada categoria

<5% 1
Estable
5% - 10% 2
10% - 15% 3 _
Bajo
15% - 20% 4
) 20% - 25% 5
Pendiente Moderado
25% - 30% 6
30% - 35% 7
Alto
35% - 40% 8
40% - 60% 9
Muy Alto
> 60% 10
Matorrales Bajo
Agricola Moderado
Montafias Alto
Llanura arenosa
Cobertura
Suelo desnudo 10
Laguna 10 Muy Alto
Rio 10
Urbana 10
Depdsito aluvial 1
. Estable
Grupo Calipuy 2
Formacion La Zorra 3 Bajo
i Formacion Lupin 5
Geologia » o Moderado
Formacion Chimu 5
Batolito de la Costa 7
> Alto
Formacion Junco 7
Formacion Santa, Carhuaz 10 Muy Alto
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Mantos de arena
Terraza aluvial

Colinas y lomadas

Montafia con pendientes
suaves a moderadas
Montafia con pendientes
moderadas a fuertes

0-150 mm
150 — 300 mm
300 — 450 mm
450 - 600 mm

Geomorfologia

Precipitacion

Intersect
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Muy Bajo
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Muy Alto
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Bajo
Alto

Muy Alto

Figura 60: Interseccidn de las cinco capas en ModelBuilder
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Finalmente, en el modelo obtenido se agregd un nuevo campo donde se ingreso la ecuacion
para hallar la vulnerabilidad de cada poligono, con la opcién Field Calculator (Figura 61),
y con los valores obtenidos se hallaron las regiones con los niveles de vulnerabilidad estable,

bajo, moderado, alto y muy alto.

Field Calculator X

FParser

(@ VB Script () Python

Fields: Type: Functions:
UNIDAD ~ | Abs ()
o GEOLO @Number Atn ()

- i Cos( }
sub_uni () string Exp ()

PV_GEOMO Fist ()

Date

PENDIENTE O Int ()
PV_PEND ;?rf’ (( ]]
PP_MEDIA_A Sqr ()
PV_FP Tan( )
P_Vulnerab

W

[ ] show Codeblock

P Vulnerab =

0.15 * [PV_COB] +0.15 * [PV_GEOLO] +0.2 * [PV_GEOMO] +0.25 * [PV_PEND]
+0.25 * [PV_PP]

About calculating fields

Clear Load... Save...

Figura 61: Célculo de la Vulnerabilidad de la cuenca Huarmey
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d. Modelo Geoespacial para la identificacion y cuantificacion de la erosion del

suelo con el método USLE

La elaboracion del mapa de erosion del suelo, se realizé de acuerdo a la formula de la USLE

propuesta por Wischmeier y Smith en 1978.

A=RXKXLXSXCXP

Donde las variables son:

A: Cantidad de pérdida de suelo en una unidad de superficie (t/ha.afio)
R: Factor de precipitacion y escorrentia (MJ.mm/ha.h.afio)

K: Factor de susceptibilidad del suelo a erosion (t.ha.h/ha.MJ.mm)

L: Factor de longitud de la pendiente

S: Factor de inclinacion de la pendiente

C: Factor de la cobertura vegetal

P: Factor de préacticas de conservacion

e Factor de Precipitacion (R)

Para la elaboracién de la capa del Factor R, se utiliz el archivo raster del mapa de
precipitaciones medias anuales, elaborado previamente, a la cual se aplicé la ecuacion de

Roose.

R=173x05x%xP

Donde:
R = Factor de erosividad de la lluvia (MJ.mm/ha.h.afo)

P = Precipitacion media anual (mm)

Para obtener el factor de erosividad de precipitacion se utilizé la aplicacion ModelBuilder,
donde se ingreso la herramienta de calculadora raster (Raster Calculator) de ArcGIS, cuya
direccién es ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator,
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para aplicar la ecuacién de Roose (figura 62). Es importante mencionar que este raster cuenta
con un tamano de celda de 30 m.

*, Raster Calculator = O X

Map Algebra expression A\

Layers and variables Conditional A

- EE EEE
aster de las precipitaciones _ SetNull
. IE0 [

LE]E] EEEE]
T E R s -

1.73 * 0.5 * "3_PPprom_hy"

Ecuacion de Roose

Output raster
| C:\Users\Lizbeth\Desktop\TESIS\METODOLOGIA\3 USLE\Factor R\Factor_R | @

v
< >

| OK | ‘ Cancel | [ Environments... | ’ Show Help >> |

Figura 62: Uso de la calculadora raster para aplicar la ecuacion de Roose

Calculator

Figura 63: Uso de ModelBuilder para calcular el Factor R
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e Factor de Susceptibilidad a erosion del Suelo (K)

El Factor K se halld, mediante las formulas de Sharpley y Williams (1990).

KUSLE = fcsand X fcl—si X forgc X fhisand

Mmgil
fcsand = (02 + 0.3 X exp—0.256><ms(1_ l(s)Lot))

Faresi = (%)0'3
cl—si m, n Mg
_ (1 0.25 X orgC )
Jorge = orgC + exp[3.72 — 2.95 X org(]
_ms
P 0.7><(1 100)
isan - —
_my —5.51422.9x(1-10s.
(1 100) + exp[ (1-705)]

Siendo:

KusLe: Factor de Susceptibilidad a erosion del Suelo
Ms: Porcentaje de arena

Mgiit: Porcentaje de limo

M¢: Porcentaje de arcilla

orgC: Porcentaje de materia organica

Para la elaboracion del mapa del Factor K, se utilizé la capa de Geologia, elaborada
previamente y se recolectaron muestras de suelo de diferentes puntos de la cuenca para

conocer las caracteristicas que poseian cada unidad.

Se llevaron a cabo visitas de campo a las zonas clasificadas y se tomaron muestras de suelo
a 45 cm. de cada una de ellas, para esta actividad se contd con la ayuda de los ingenieros de

la Agencia Agraria de Huarmey, como se muestra en las siguientes fotografias.
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Figura 65: Toma de muestras en la unidad Deposito Aluvial
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Figura 67: Toma de muestras en la unidad Formacion Junco
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Toma de muestras en la un

Figura 68
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Toma de muestras en la unidad Formacion

Figura 69
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Figura 71: Toma de muestras en el Grupo Calipuy
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Una vez recopiladas las muestras, estas fueron enviadas al Laboratorio de Suelos de la
Universidad Nacional Agraria La Molina (UNALM), para el célculo de los porcentajes de

arena, arcilla, limo y materia organica (Anexo 11).

Los resultados de los porcentajes de arena, arcilla, limo y materia organica se ingresaron a
una hoja Excel, y se realizo el célculo del Factor K. La tabla de valores de “K” para cada

unidad geologica de la cuenca se muestra en la Tabla 14.

Luego, se ingresaron los valores de “K” a la Tabla de Atributos del archivo en shape de las

unidades geoldgicas de la zona de estudio.

Tabla 14: Valores del Factor K

Materia

) @) ) OHNe K

26 17 132 0145
93 2 5 002  0.063
66 16 18 497 0117
47 34 19 054 0172
79 12 9 015  0.134
79 12 9 015  0.34
74 16 10 345  0.17
44 28 28 175 0.27

Después, se utilizo la herramienta Polygon to Raster en el espacio de ModelBuilder, donde

Arena Limo Arcilla

Unidades de Suelo

se especificaron que los valores de campo (Value Field) para obtener el réster son los del
Factor K, hallados en la Tabla 14, asi mismo se ingreso la ruta de salida y el tamafio de celda

de 30 m. (utilizado en todos los raster de esta tesis).

Figura 72: Uso de ModelBuilder para hallar el Factor K
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e Factor Topogréfico (LS)

Para hallar este factor, se utilizd la capa de pendientes en porcentajes y se reclasificaron los

valores, con la funcién Reclassify, de acuerdo a los rangos de la tabla elaborada por la

Facultad de Hidraulica e Hidrologia de la Escuela Técnica Superior de Ingenieros de Montes

de Madrid (Figura 73). Luego, el raster reclasificado fue convertido a un archivo shape con

la herramienta Raster to Polygon y después se utilizd la funcion Dissolve para sintetizar los

datos.

ke B s o

Classification

Classification
Method: Manual

Classes: ]

Data Exclusion

Columns: 100 |5

Exclusion ...

Sampling ...

|:| Show Std. Dev. |:| Show Mean

e
Classification Statistics
Count: 2494436
Minimum: a
Maximum: 266.948273
Sum: 93800339.546477
Mean: 37.603827
Standard Deviation: 26.684731

1 I I
66737068 133474136 200211205 266.94827.

[ ]snap breaks to data values

Figura 73: Reclasificacion de las pendientes
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En la tabla de atributos de la capa resultante, se afiadié un nuevo campo donde se ingresaron
los valores de LS de acuerdo al grupo de pendientes (Figura 74). Por ultimo, se convirtio la
capa vectorial a raster nuevamente, con un tamario de celda de 30 m., pero a diferencia del
primer raster con los valores de las pendientes, en este Ultimo se tomaron en cuenta los

valores de LS en Value Field.

Table o x
ERAE-RAL LA
FACTOR LS x
FID Shape * GRIDCODE FACTOR_LS
3 0} Polygon 1 0.3
1|Pualygon 2 1.5
2|Paolygon 3 34
3 [Polygon 4 56
4|Polygon 5 8.7
5 [Polygon B 14.6
6 [Folygon 7 202
7 [Polygon B 252
g [Polygon 9 28.5
TR 1 » » [E|= (0 out of 9 Selected)

Figura 74: Adicion del Campo LS en la Tabla de Atributos

e Factor de Cobertura Vegetal (C)

Para hallar el Factor C se requiri6 del uso del Mapa de Cobertura de la cuenca, generado en
la seccion de Construccion de Base de Datos Geoespaciales, para reclasificar las clases
originales del cero a uno. Estos nuevos valores representaron el nivel en que cada tipo de
cobertura afecta en la tasa de erosion. Para las areas con una mayor cobertura vegetal, se les
asignaron valores de C cercanos a cero, y para las zonas con superficie desprotegida, valores

cercanos a uno. Los valores que fueron asignados a cada clase se muestran en la Tabla 15.
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Tabla 15: Valores del Factor C

Agricola 0.3
Laguna 1
Llanura arenosa 1
Matorrales 0.2
Montafias 0.7
Rio 1
Suelo desnudo 1
Urbana 0.8

Estos valores se agregaron en la Tabla de Atributos del archivo en formato shape de la
cobertura de la cuenca y luego, se procedié con la conversién a formato raster (30 m.) de
este archivo, tomando en cuenta los valores del Factor C, en la aplicacién ModelBuilder
(Figura 75).

-~
Polygon to
Raster =

Figura 75: Uso de ModelBuilder para hallar el Factor C
e Factor de Précticas de Conservacion (P)
Este factor representa la actividad de proteccion contra la erosion debida a fuertes

escorrentias, sin embargo, debido a que estas practicas no se presentan en el area de estudio,

se otorgd el valor de uno en la ecuacion.
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e ldentificacion y cuantificacion de la erosion hidrica (USLE)

Finalmente, una vez obtenido los factores R, K, LS y C, que requeria la ecuacion USLE, con
un mismo tamafio de celda de 30 m., se procedi6 con el modelamiento geoespacial para la
integracion de variables, mediante la multiplicacion de estos parametros con la funcién

Raster Calculator (figura 76).

s
Raster
Calculator

Figura 76: Modelamiento geoespacial para hallar la ecuacion USLE
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IV. RESULTADOS Y DISCUSION

4.1. 1™ FASE DE GEOPROCESAMIENTO

Como resultado del primer geoprocesamiento de los datos de la cuenca se obtuvo la siguiente

informacion tematica.

4.1.1. Cobertura Vegetal

El resultado de la clasificacion no supervisada se mostro en la Figura 77, sin embargo, este
primer mapa no cuenta con una division clara de los siete tipos de cobertura. Luego, se
efectud la clasificacion supervisada, que cont6 con 11 clases de cobertura (Figura 78), a la
cual se le hicieron correcciones utilizando el programa Google Earth Pro y la informacion

obtenida de las visitas de campo.

Como resultado de la clasificacion final de la cuenca Huarmey, se obtuvieron ocho tipos de
cobertura. La clase que abarcd una mayor area, fue la de Matorrales, cuya superficie fue de
1410.25 km?, lo que equivalio al 62.82 por ciento del area total y se ubicd desde la parte
media a alta de la cuenca, en la zona andina. En la zona media a baja de la cuenca se
encontraron las Montafias, cuya area fue la segunda mas grande, con 476.22 km?, que
representd el 21.21 por ciento de la superficie de la cuenca. Por otro lado, en la cuenca baja
se hall¢ la clase de Llanura Arenosa, con 119.18 km?, que comprendio el 5.31 por ciento del
area de estudio. Las areas agricolas se encontraron a lo largo de toda la cuenca y contaron
con una superficie de 128.08 km?, lo que significé el 5.71 por ciento del area total. Las zonas
de Suelo Desnudo tuvieron un area de 101.53 km?, lo que representé el 4.52 por ciento.

Finalmente, el resto de tipos de cobertura abarcaron menos del uno por ciento del area total.
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Tabla 16: Resultados del mapa de cobertura

Clases Area (km?) Area (%)

Agricola 128.08 571
Laguna 3.21 0.14
Llanura arenosa 119.18 531
Matorrales 1410.25 62.82
Montafias 476.22 21.21
Rio 2.14 0.10
Suelo desnudo 101.53 4.52
Urbana 4.29 0.19
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4.1.2. Pendiente

Se obtuvo un mapa de pendientes en porcentajes, el cual mostré que el rango de 40 a 60 por
ciento, representaron a los terrenos escarpados, y son los que poseen mayor area en la cuenca,
contando con 520.28 km?, lo que significd un 25.40 por ciento del area total. La segunda
zona con mayor area, fue la que presentaba pendientes de 20 a 40 por ciento, con un area de
565.99 km?, equivalente al 25.21 por ciento del total de la superficie. Las pendientes mayores
al 60 por ciento, fue la tercera regidbn mas grande, cuyo terreno era extremadamente
empinado y abarcé una superficie de 476.96 km?, que represento el 21.25 por ciento de la
zona de estudio. El rango de pendientes menores a 5 por ciento present6 un area de 360.05
km?, abarcando el 16.04 por ciento del &rea total. Por tltimo, los rangos restantes de 5 a 10

por ciento y de 10 a 20 por ciento, ocuparon areas menores al 10 por ciento de la cuenca.

Tabla 17: Resultados del mapa de pendientes en porcentaje

<5% 360.05 16.04
5% - 10% 77.63 3.46
10% - 20% 193.99 8.64
20% - 40% 565.99 25.21
40% - 60% 570.28 25.40

> 60% 476.96 21.25
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4.1.3. Capacidad de Infiltracion

Esta capa se realizé gracias al Mapa de Hidrogeologia Nacional del INGEMMET, donde
resultaron tres tipos de suelo dentro de la cuenca Huarmey, que se muestra en la figura 81.
En la tabla 18 se puede observar, que el suelo tipo A, cuya capacidad de infiltracion es alta,
abarcé un area de 614.53 km?, correspondiente al 27.37 por ciento de la superficie total de
la cuenca, y que se halla en la parte baja de la unidad hidrogréafica. Los suelos de tipo B,
cuentan con un nivel medio de permeabilidad, y fue la zona que cont6 con la mayor area,
1286.96 km?, lo que significo el 57.33 por ciento y se puede observar principalmente en la
parte alta de la cuenca. Por Gltimo, los suelos de tipo C, presentaron una capacidad de
infiltracion baja y present6 un area de 343.41 km?, que represento el 15.30 por ciento del

total y se encontraron en la parte media de la cuenca, a los lados del valle.

Tabla 18: Resultados del mapa de capacidad de infiltracion

Alta A 614.53 27.37
Media B 1286.96 57.33
Baja C 343.41 15.30
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4.1.4. Geologia

Ochos unidades geoldgicas conformaron la cuenca Huarmey, siendo el Grupo Calipuy,
localizado en la parte mas alta de la cuenca y compuesto principalmente por lavas andesiticas
y piroclastos, el que abarcé la mayor area, con 748.39 km? que representd el 33.34 por ciento
del total. La segunda unidad més grande fue la Formacion Junco, caracteristico por la
presencia de lavas almohadilladas, con un area de 484.89 km?, que signific el 21.60 por
ciento de la superficie de la cuenca. La tercera unidad que predominé fue el Batolito de la
Costa, constituido por colinas y montafias de monzogranito en la zona media de la cuenca,
cuya superficie fue de 467.45 km?, equivalente al 20.82 por ciento. Los depoésitos aluviales,
que se encontraron a lo largo del valle y en las zonas de suelo desnudo, ocuparon 248.56
km?, comprendiendo el 11.07 por ciento del area total, siendo la cuarta unidad mas
sobresaliente. Las cuatro formaciones geologicas restantes solo ocuparon menos del 6 por

ciento del area de la cuenca cada una.

Tabla 19: Resultados del mapa de geologia

Batolito de la 467 45 20.82
Costa
Depésito aluvial 248.56 11.07
Formacién Chimu 32.03 1.43
Formacion Junco 484.89 21.60
Formacion La 98.85 4.40
Zorra
Formacién Lupin 45.43 2.02
Formacidén Santa, 11941 530
Carhuaz
Grupo Calipuy 748.39 33.34
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4.1.,5. Geomorfologia

Se identificaron cinco unidades geomorfoldgicas en la zona de estudio, de las cuales la que
predominod fueron las Montafias con pendientes moderadas a fuertes, ubicada en la zona
media a alta de la cuenca y que abarco un area de 1407.73 km?, significando el 62.71 por
ciento de la superficie total. Las Colinas y lomadas, fue la segunda unidad mas grande, que
se encontrd principalmente en la zona media de la cuenca, con una superficie de 322.18 km?,
que representd el 14.35 por ciento del total. Asi mismo, las Montafia con pendientes suaves
amoderadas contaron con un area de 198.27 km?, equivalente al 8.86 por ciento. Los mantos
de arena ubicados en la region costera tuvieron un area de 170.78 km?, ocupando el 7.61 por
ciento del area total. Finalmente, la Terraza Aluvial localizada en la zona de los valles y

quebradas, presentaron una superficie de 146.04 km?, que significo el 6.50 por ciento del

total de la cuenca.

Tabla 20: Resultados del mapa de geomorfologia

Colinas y lomadas 322.18

Mantos de arena 170.78
Montarfias con pendientes

198.27
suaves a moderadas
Montafias con pendientes 1407.73
moderadas a fuertes
Terraza aluvial 146.04
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4.1.6. Factor Forma

Se llevo a cabo la clasificacion de los valores del factor forma de las cuencas, basado en la
Tabla 3, de acuerdo a Pérez, citado por Cordova (2016). Por lo tanto, se obtuvo ocho tipos
de formas en toda la cuenca, como se muestra en la Tabla 21. La forma que mas predomino
entre las cuencas, fue la del tipo Ligeramente Ensanchada, la cual ocupd un area de 450.07
km?, siendo éste el 20.05 por ciento del area total. Las cuencas con forma Muy Ensanchada,
tuvieron un area de 412.01 km?, lo que significo el 18.35 por ciento. El tercer tipo de cuencas
con mayor area, fueron las de la forma Ligeramente Alargada, cuya superficie fue de 383.63
km?, equivalente al 17.09 por ciento. Las cuencas de forma Alargada, contaron con 309.05
km? de area, que significo el 13.77 por ciento. Las cuencas clasificadas como Ni Alargadas
Ni Ensanchadas, tuvieron una superficie de 247.34 km?, ocupando el 11.02 por ciento del
total de la cuenca. Los tres tipos de forma restante, Muy Alargada, Ensanchada y Rodeando
el desaglie, alcanzaron areas menores al 10 por ciento del total cada una, la primera con
189.03 km? (8.42 por ciento), la segunda con 167.54 km? (7.46 por ciento) y la tltima con
86.33 km? (3.85 por ciento).

Tabla 21: Resultados del mapa de factor forma

Muy Alargada 189.03 8.42
Alargada 309.05 13.77
Ligeramente Alargada 383.63 17.09
N'Eﬁs':;%";‘]‘;?i;\“ 247.34 11.02
Ligeramente Ensanchada 450.07 20.05
Ensanchada 167.54 7.46

Muy Ensanchada 412.01 18.35
Rodeando el desague 86.33 3.85
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4.1.7. Precipitacion

Las precipitaciones que se obtuvieron en este mapa fueron obtenidas como un promedio
anual (mm/afio). Como se muestra en figura 85, el 44.99 por ciento de la superficie de la
cuenca, 0 1009.98 km?, presenta lluvias entre el rango de 0 a 150 mm/afio, las cuales se
manifiestan en la zona media y baja de la cuenca. Las precipitaciones van aumentando, a
medida que la altura aumenta también, es por ello que el siguiente rango de 150 a 300
mm/afio, se encuentra en la zona media de la cuenca, ocupando 268.48 km?, equivalente al
11.96 por ciento del total. La parte media a alta de la unidad hidrogréafica presenta un rango
de precipitaciones del 300 a 450 mm/afio, con una superficie de 306.32 km?, que significo
el 13.64 por ciento. En la parte mas alta de la cuenca, se ubico el rango de 450 a 600 mm/afio,
siendo esta zona la segunda con mayor érea, la cual fue de 600.21 km?, ocupando el 29.41

por ciento del total de la cuenca.

Tabla 22: Resultados del mapa de precipitaciones

0-150 1009.98 44.99
150 - 300 268.48 11.96
300 - 450 306.32 13.64
450 - 600 660.21 29.41

113



8840000 8860000 8880000 8900000 8920000 8940000

8820000

160000

180000 200000
| |

220

000

{

INTERCUENCA
1375959

‘»

MAPA DE PRECIPITACIONES
DE LA CUENCA HUARMEY

CUENCA CASMA

CUENCA CULEBRAS

N

CUENCA
SANTA

Jo 357
-I_:_

Wi

INTERCUENCA
137593

CUENCA

A FORTALEZA

Leyenda

|:| Cuencas Hidrogrdficas

Datum: WGS 1984
Unidades: Metros
Escala 1:650,000

Sistema de Coordenadas:
WGS 1984 UTM Zona 18S

PP media anual - -
(mm/afio) Area (km2) | Area (%)
0-150 1009.98 44 99
b
150 - 300 268.48 11.96
l\ - 300 - 450 306.32 13.64
450 - 600 660.21 29.41

14 21

Kllometers \<

8820000

(f\

160000

180000 200000

220

000

Figura 85: Mapa de precipitaciones de la cuenca Huarmey

114

8860000 8880000 8900000 8920000 8940000

8840000



4.2. 29 FASE DE GEOPROCESAMIENTO

4.2.1. Mapa de Inundaciones Extraordinarias

Luego de realizar la superposicién ponderada de las capas de Cobertura, Pendiente,
Capacidad de Infiltracion y Factor Forma se obtuvo el Mapa de Inundaciones
Extraordinarias (figura 86), donde se muestran los niveles de amenaza ante fuertes
precipitaciones imprevistas. Los resultados indicaron que el area de la cuenca que presento
un nivel muy bajo de amenaza fue de 67.79 km?, el cual representd el 3.02 por ciento de la
superficie total. La zona que conté con un nivel bajo de vulnerabilidad ante estas
inundaciones, fue la que cont6 con la mayor area, la cual fue de 1025.28 km?, lo que significo
el 45.67 por ciento de la cuenca. El sector de la cuenca con un moderado nivel de amenaza,
contd con 804.22 km? de éarea, abarcando el 35.82 por ciento del total, siendo esta zona la
segunda mas grande. La region de la cuenca con un alto nivel de vulnerabilidad ante este
fendmeno, se ubico principalmente en la zona del valle y en la parte baja cerca a la costa, y
tuvo un area de 345.90 km?, comprendiendo el 15.41 por ciento. Por ultimo, la zona con un
nivel muy alto de amenaza present6 una superficie de 1.71 km?, representando solo el 0.08

por ciento de la superficie.
Asi mismo, se puede observar que los puntos donde se registraron inundaciones en el afio
2017 por el fenémeno del Nifio Costero, coinciden con la zona con un nivel alto y muy alto

de susceptibilidad ante inundaciones extraordinarias.

Tabla 23: Resultados del mapa de inundaciones extraordinarias

Muy Alto 1.71 0.08
Alto 345.90 15.41
Moderado 804.22 35.82
Bajo 1025.28 45.67
Muy Bajo 67.79 3.02
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4.2.2. Mapa de Inundaciones, considerando PP

Este segundo modelo (figura 90), fue creado con la superposicion de las capas de
Precipitaciones, Cobertura, Pendiente, Capacidad de Infiltracion y Factor Forma. Existen
solo algunas variaciones en los niveles de vulnerabilidad ante inundaciones, respecto al

primer modelo, a causa de la consideracion de las precipitaciones en este mapa.

La zona con un muy bajo nivel de amenaza present6 un area de 66.60 km?, equivalente al
2.97 por ciento del total. Al igual que en el modelo anterior, el sector con mayor superficie
fue el de nivel bajo, la cual contd con un area de 1092.77 km?, que representd el 46.68 por
ciento de la cuenca. La region de la cuenca con un nivel moderado de amenaza ante
inundaciones abarcé 721.39 km?, que significo el 32.13 por ciento. La superficie de la zona
con un nivel alto de vulnerabilidad, fue de 360.53 km?, que representé el 16.06 por ciento
de la cuenca, y tal como sucedié en el primer mapa de inundaciones, se localizé en el valle
de la cuenca, y en la parte baja cerca a la costa, solo se observaron diferencias en la parte
mas alta de la cuenca, donde se incrementaron las regiones de alto nivel de vulnerabilidad
debido a las fuertes precipitaciones que se producen anualmente. Las zonas con un nivel
muy alto de amenaza, fueron las mas pequefias con un area de 3.62 km?, equivalente al 0.16

por ciento del total.

Tabla 24: Resultados del mapa de inundaciones, considerando PP

Muy Alto 3.62 0.16
Alto 360.53 16.06
Moderado 721.39 32.13
Bajo 1092.77 48.68
Muy Bajo 66.60 2.97
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Figura 90: Mapa de inundaciones de la cuenca Huarmey, considerando la capa de

Precipitaciones
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4.2.3. Mapa de Vulnerabilidad Fisica

Este mapa se creo con el fin de hallar las zonas mas vulnerables de la cuenca, para realizar
una comparacion con el modelo USLE y comprobar que las zonas mas peligrosas
concuerden. Los sectores con un nivel muy alto de vulnerabilidad se presentan en la zona
mas alta de la cuenca debido a las pendientes escarpadas de la regién y la presencia de fuertes
lluvias, abarcando un area de 79.39 km?, equivalente al 3.54 por ciento. Por otro lado, las
zonas con un nivel alto de vulnerabilidad contd con una superficie de 886.89 km?,
representando el 39.51 por ciento del area total, que abarca la misma zona que el rango de
50 a 200 t/ha.afio de pérdida de suelo en el modelo USLE, en la parte alta de la cuenca. Las
zonas con nivel estable y bajo mantuvieron una relacién con los menores rango de pérdida
de suelo en el mapa USLE, del mismo modo sucede con el nivel moderado, y estos rangos
se encuentra en la parte media y baja de la cuenca, donde las pendientes y precipitaciones

Son menaores.

Tabla 25: Resultados del mapa de vulnerabilidad fisica de la cuenca Huarmey

Muy Alto 79.39 3.54
Alto 886.89 39.51
Moderado 819.22 36.49
Bajo 392.24 17.47
Estable 67.16 2.99
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Figura 91: Mapa de Vulnerabilidad Fisica de la cuenca Huarmey
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4.2.4. Modelo Geoespacial para la identificacion y cuantificacion de la erosion del
suelo con el método USLE

a. Factor de Precipitacion (R)

Los valores del Factor R, se clasificaron en cinco rangos con un intervalo de 100, los cuales
al igual que en el mapa de precipitaciones, se observa que van aumentando a medida que la
altura se incrementa. De este modo, la cuenca baja presento6 el rango de 0 a 100, lo cual
abarcé la mayor parte de la zona, con un area de 933.35 km?, que representd el 41.57 por
ciento del total de la superficie. Por otro lado, la segunda zona con mayor area, fue la que se
encontro en el rango de 400 a 501.22, la cual contd con un area de 621.24 km?, que significo
el 27.67 por ciento de la cuenca, y se encontrd en la parte alta de ésta. El tercer rango con
mayor cobertura fue el de 300 a 400, que abarcé un area de 283.35 km?, equivalente al 12.62
por ciento del total, y se encontr6 en la parte media y alta de la cuenca, donde la altura va
disminuyendo. El rango de 100 a 200 tuvo un area de 231.85 km?, cubriendo un 10.33 por
ciento de la cuenca. El rango con menor area fue el de 200 a 300, el cual abarco una superficie

de 175.21 km?, que represento el 7.80 por ciento del total del area.

Tabla 26: Resultados del mapa de Factor R

0-100 933.35 41.57
100 - 200 231.85 10.33
200 - 300 175.21 7.80
300 - 400 283.35 12.62

400 - 501.22 621.24 27.67
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b. Factor de Susceptibilidad a erosion del Suelo (K)

Los valores del Factor K se clasificaron en cinco rangos, como se muestra en la Tabla 27. El
rango de 0.15 a 0.17, que fueron los mayores valores de K, abarcaron un area de 952.25 km?,
equivalente al 42.42 por ciento y se encontrd en la parte media y baja de la cuenca. El
siguiente sector mas grande, fue el de 0.13 a 0.14, cuya superficie fue de 748.37 km?,
representando el 33.34 por ciento del area, localizandose en la zona maés alta de la cuenca.
La categoria con los valores de 0.06 a 0.12 contd con un area de 248.66 km?, y abarco el
11.08 por ciento de la cuenca, en la region de los valles y suelo desnudos. Asi mismo, en la
cuenca alta se encontro el rango de 0.12 a 0.13, que abarco 151.48 km?, o el 6.75 por ciento
de la cuenca. La region mas pequefia fue la de la categoria de 0.14 a 0.15, con una superficie

de 144.22 km?, equivalente al 6.42 por ciento del total.

Tabla 27: Resultados del mapa de Factor K

0.06 - 0.12 248.66 11.08
0.12-0.13 151.48 6.75
0.13-0.14 748.37 33.34
0.14-0.15 144.22 6.42
0.15-0.17 952.25 42.42
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c. Factor Topogréfico (LS)

Los resultados obtenidos se presentaron en la Tabla 28. El rango que contd con una mayor
area fue la de 14.60 a 25.20, ocupando 1076.24 km?, que representd el 47.94 por ciento del
total del area y correspondieron a las altas pendientes de la zona de estudio. La segunda zona
con mayor superficie, fue la que contd con los menores valores de LS, 0.30 a 1.50, con un
area de 323.63 km?, abarcando 14.42 por ciento de la cuenca, localizado en la zona llana de
la cuenca. EI tercer rango con mayor area, fue la de 5.60 a 14.60, y cont6 con un area de
305.90 km?, equivalente al 13.63 por ciento. Las pendientes con mayor inclinacion dieron
como resultado los valores de 25.2 a 28.5 y abarcaron un area de 277.37 km?, ocupando el
12.36 por ciento del area total. Finalmente, el rango de 1.50 a 5.60 tuvo la menor area, con

261.75 km?, equivalente al 11.66 por ciento.

Tabla 28: Resultados del mapa de Factor LS

03-15 323.63 14.42
15-56 261.75 11.66
5.6-14.6 305.90 13.63
14.6-25.2 1076.24 47.94
25.2-28.5 277.37 12.36
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d. Factor de Cobertura Vegetal (C)

Los resultados obtenidos en el mapa de cobertura (Figura 79), se le asignaron valores de C
que estuvieron dentro del rango de cero a uno. Debido a que los Matorrales ocuparon la
mayor parte de la cuenca, su valor correspondiente de C de 0.20 fue la més grande, abarcando
un area de 1410.33 km?, que representd el 62.82 por ciento de la superficie total. Los valores
de C de 0.7 a 0.8, que pertenecieron a la zona de Montafias de la parte media de la cuenca y
la zona urbana, presentd un area de 480.52 km?, equivalente al 21.40 por ciento de la cuenca.
Los valores de C de 0.9 a 1, se presentaron en la superficie sin cobertura vegetal, y cont6
una superficie de 225.90 km?, que significd el 10.06 por ciento, siendo la tercera zona mas

grande. Los demas valores contaron con superficies menores al 10 por ciento.

Tabla 29: Resultados del mapa de Factor C

0-0.2 1410.33 62.82
0.3-04 128.15 5.71
0.5-0.6 0.00 0.00
0.7-0.8 480.52 21.40

09-1 225.90 10.06
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e. Mapa de Identificacién y Cuantificacion de la Erosion Hidrica (USLE)

Como se muestra en la Figura 97, la zona donde se registraron las mayores pérdidas de suelo
por erosion hidrica, de mas de 200 t/ha.afio, fue en la parte alta de la cuenca, debido a que
en este sector se producen las mayores precipitaciones y existen pendientes altas, y contd
con un area de 245.21 km?, equivalente al 10.92 por ciento del total de la cuenca. Por otro
lado, la region con mayor area fue lo del rango de 50 a 200 t/ha.afio, que abarco un area de
945.30 km?, abarcando el 42.11 por ciento del total, y present6 estos valores ya que es en
esta zona donde se presentan precipitaciones significativas y cuenta con pendientes elevadas.
La region con erosiones de 0 a 5 t/ha.afio y de 5 a 10 t/ha.afio fue la mas segura y cuya

superficie fue de 632.55 km?, representando el 28.18 por ciento.

Tabla 30: Resultados del mapa de cuantificacion de la erosién hidrica de la cuenca

Huarmey
0-5 437.35 19.48
5-10 195.20 8.70
10 - 50 421.84 18.79
50 - 200 945.30 42.11
> 200 24521 10.92
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V. CONCLUSIONES

De acuerdo al objetivo general de la presente investigacion se logro identificar las zonas
vulnerables a inundaciones y procesos de erosion; asi como cuantificar la cantidad la
pérdida de suelo por erosion, mediante la aplicacion del sistema de informacion
geografica (SIG), generando los modelos de inundaciones extraordinarias, inundaciones,
vulnerabilidad fisicay USLE.

Se elaboré una Base de Datos Geoespacial con siete variables tematicas, las cuales
fueron utilizadas para elaborar los modelos de inundaciones, inundaciones
extraordinarias y vulnerabilidad fisica; asi como para cuantificar la pérdida de suelos en

la cuenca Huarmey.

El Mapa de Inundaciones Extraordinarias fue el primer modelo geoespacial que se
elaboro, y cuyo principal factor que influy6é en la formacion de inundaciones fue la
informacion tematica de pendientes. Este modelo mostrd cinco niveles de riesgo a
inundaciones, muy bajo, bajo, moderado, alto y muy alto. Las zonas con nivel muy bajo
se encuentran en la parte méas alta de la cuenca, abarcando un area de 67.8 km?, donde
las pendientes son escarpadas y existe mayor cobertura vegetal; las de nivel bajo se
ubican en la zona de los matorrales en la parte media a alta de la cuenca, con un érea de
1025.3 km?; y la de nivel moderado contd con un area de 804.2 km? principalmente en
la zona de las colinas de la parte media de la cuenca. La zona que presentd un nivel alto
de riesgo por inundaciones extraordinarias, se ubicé en la parte media y baja de la cuenca,
donde se ubican los valles, el suelo desnudo y la llanura arenosa, ocupando un area de
345.9 km?, esto debido principalmente a la presencia de pendientes muy suaves y a una
escasa cobertura vegetal, existente solo en las zonas agricolas. Asi mismo, gracias al
mapa que muestra los puntos donde se produjeron las inundaciones en el afio 2017 a
causa del Fenémeno del Nifio Costero (Figura 87), se observo que la localizacion de
estos eventos coincide con las zonas con un nivel alto de riesgo por inundaciones del

Mapa de Inundaciones Extraordinarias.
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El Mapa de Inundaciones result6 del segundo modelamiento geoespacial, que de igual
forma fue la variable pendiente la que tuvo una mayor influencia en la formacion de
inundaciones. En este modelo la zona de vulnerabilidad alta, no presento variaciones
significativas respecto al primer mapa, solo se presentd un incremento en su area,
llegando a ser de 360.5 km?, esto debido principalmente a que en la parte alta de la
cuenca aumentd la superficie por la incorporacion de los datos de precipitaciones, que

son significativas en esta zona.

El Mapa de Vulnerabilidad Fisica fue el tercer modelo elaborado, cuyos principales
factores que influyeron fueron las pendientes y las precipitaciones. Asi mismo,
presento cinco niveles de vulnerabilidad que fueron estable, bajo, moderado, alto y
muy alto. La zona de vulnerabilidad estable se presentd en la parte mas baja de la
cuenca, en la llanura arenosa donde las pendientes son muy bajas y las precipitaciones
escasas, con un area de 67.2 km?; la de vulnerabilidad baja cont6 con un area de 392.2
km?, principalmente en la zona de los valles donde las pendientes y las precipitaciones
son bajas; y la de nivel moderado se ubicé en la parte media de la cuenca donde las
pendientes son escarpadas y las precipitaciones moderadas, con una superficie de
819.2 km?. Las regiones con los niveles de vulnerabilidad alta y muy alta, presentaron
areas de 886.9 km? y 79.4 km? respectivamente, y se localizaron en la zona de los
matorrales y montafias, donde se producen fuertes precipitaciones y las pendientes
van de moderada a altas, en centros poblados como La Merced, Aija, Huacllan y

Malvas.

El Mapa de la Identificacion y Cuantificacion de la Erosion Hidrica de la Cuenca
Huarmey, segun el método USLE, integro los factores de precipitaciones, topografia,
cobertura y suelo. Este fue el ultimo modelo geoespacial que se elabord, en donde la
cantidad de suelo perdido por erosion se clasifico en cinco niveles, las cuales fueron
estable, bajo, moderado, alto y muy alto. La zona clasificada con un nivel estable, que
presentd el rango de 0 a 5 t/ha.afio, abarco un area de 437.4 km? y se localizé en la
zona de los valles y la llanura costera, donde las pendientes son suaves y las
precipitaciones escasas; la de nivel bajo, con un rango de 5 a 10 t/ha.afio, contd con
un area de 195.2 km? y se ubico en la parte media de la cuenca al lado de los valles,
donde las pendientes son moderadas y las precipitaciones minimas; y la de nivel

moderado, cuyo rango fue de 10 a 50 t/ha.afio, tuvo un area de 421.8 km? y se presentd
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en la parte media de la cuenca, donde se encuentran las colinas con pendientes
moderadas a leves y las precipitaciones que se producen son minimas. Las zonas con
un nivel alto y muy alto de erosion, con un rango de 50 a 200 t/ha.afio y de 200 t/ha.afio
a mas, presentaron areas de 945.3 km? y 245.2 km? respectivamente, y se localizaron
en la zona de los matorrales y montafas, cuyas pendientes van de moderadas a
escarpadas y se registran fuertes precipitaciones, en centros poblados como La

Merced, Aija, Huacllan y Malvas.
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VI. RECOMENDACIONES

Se recomienda considerar los resultados obtenidos en la presente investigacion
respecto a la localizacion de las zonas vulnerables a inundaciones y procesos de
erosion para los planes de desarrollo en la cuenca Huarmey, por parte de las entidades

publicas y privadas.

La Base de Datos Geoespacial es importante para la identificacion de zonas
vulnerables en la cuenca, razon por la cual se recomienda mantener actualizada la
data, para que los modelos se optimicen y puedan ser utilizados para la elaboracion
de planes, programas, proyectos y actividades en la cuenca del rio Huarmey.

En base a la experiencia, se aconseja la aplicacion de tecnologias de los Sistemas de
Informacion Geografica y la Teledeteccion, para obtener otros modelos que muestren
zonas susceptibles a diferentes desastres, y puedan ser utilizados en la elaboracion de

planes, programas, proyectos y actividades en las cuencas hidrograficas

La cobertura vegetal es un factor importante para reducir la erosion de una zona, es
por ello que se recomienda como practica de conservacion, implementar la
agroforestacion en las partes altas de la cuenca, ya que con ello se podria proteger al
suelo de la erosion gracias a las raices profundas y la caida de las hojas, asi mismo
esto produce que se mejore la capacidad de infiltracion del suelo. Cabe resaltar que
como medidas de mantenimiento se deben prohibir las quemas en la zona, asi como

evitar el pastoreo libre en los primeros tres afos.

Asi mismo, se recomienda utilizar la informacion de la presente investigacion para
desarrollar actividades como la cosecha de aguas de lluvia y la implementacion de
surcos en contorno, zanjas de infiltracion, terrazas, entre otros; en la parte alta y media

de la cuenca para que se pueda captar este recurso hidrico en los meses de fuertes
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precipitaciones y sea utilizado en los meses posteriores. Estas practicas de
conservacion ayudan a que el exceso de lluvia sea utilizado para el consumo familiar

0 actividades agricola, y de este modo no se pierda y ocasione erosion en los suelos.

Por otro lado, la limpieza de los cauces, la descolmatacion de rio, la implementacion
de defensas riberefias en la parte baja de la cuenca son actividades fundamentales para
mitigar el riesgo de inundaciones. Es importante concientizar a las autoridades sobre
estas medidas de prevencion que pueden evitar dafios en la poblacion y sus

actividades.
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VIIl. ANEXOS

e ANEXO1

Valores de C correspondiente al tipo de cobertura, segun Montes-Leén et al. 2011

Vegetacion y/o uso de suelo C Vegetacion y/o uso de suelo C
Bosque de ayarin 0.01 Pastizal gipsofilo 0.25
Bosque de cedro 0.01 Pastizal halofilo 025
Bosque de encino 0.10 Pastizal inducide 0.02
Bosque de encino-pino 0.01 Pastizal natural 0.07
Bosque de galeria 0.10 Popal 0.85
Bosque de oyamel 0.01 Pradera de alta montafia 0.05
Bosque de pino 0.01 Sabana 054
Bosque de pino-encing 0.01 Sabanoide 054
Bosque de tascate 0.01 Selva alta perennifolia 045
Bosque de mesofilo de montaria 0.01 Selva alta subperennifolia 045
Chaparral 0.65 Selva baja caducifolia 0.50
Manglar 010 Selva baja espinosa caducifolia 050
Matorral crasicaule 0.65 Selva baja espinosa subperennifolia 0.50
Matorral de coniferas 0.20 Selva mediana caducifolia 045
Matorral desértico microfilo 0.25 Selva mediana perennifclia 045
Matorral desértico roetofilo 025 Selva mediana subcaducifolia 045
Matorral espinoso tamaulipeco 0.45 Tular 0.10
Matorral rosetofilo costero 025 Vegetacion de desiertos arenosos 0.85
Matorral sarcocaule 0.25 Vegetacion de dunas costeras 0.85
Matorral sarco-crasicaule 025 Vegetacion de galeria 0.85
Matorral sarco-crasicaule de neblina 0.25 Vegetacion halofila 0.85
Matorral submontane 0.35 Zona urbana 0.005
Matorral subtropical 0.12 Cuerpos de agua 10
Mezquital 0.65 Agricultura en riego 055
Palmar inducido 073 Agricultura de temporal 073
Palmar natural 07 Agricultura de humedad 025
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ANEXO 2

Valores de C correspondiente al tipo de cobertura vegetal, segun Wischmeier, citado

por Ramos Taipe 2001

Cultivo y practica Media anual del
factor C
Suelo desnudo 1.0
Bosgue o matorral denso (alto mulch) 0.001
Pradera herbacea en buenas condiciones 0.01
Pradera sobrepastoreada 0.1
Maiz, sorgo, alto rendto_, laboreo convencional 0.20-055
Maiz, sorgo, alto rendto. sin laboreo convencional 0.50-02590
Maiz, sorgo, bajo rendto_laboreo minimo 002-010
Maiz, sorgo, alto rendto_, laboreo con chisel 012-020
Maiz, sorgo, bajo rendto_, laboreo con chisel 030-045
Algodon 0.40-0.70
Pradera herbacea 0.01-0025
Soya 0.20-050
Trigo 0.10-040
Arroz 010-020
Cacahuate 0.30-0.280
Frutales con cobertura vegetal 001-08
Cafia de azucar 0.56
Arbolado denso 0,001-0,003
Arbolado forestal clareado 0,003-0,009
Arbolado muy clareado (25-60%) 0,041
Matorral con buena cobertura 0,003-0,013
Matorral ralo y eriales 0,200,013
Cultivos anuales y herbaceos 0,25
Pasturas 0,15
Plantas herbaceas y matojos (100%) 0,003
Plantas herbaceas y matojos (60%) 0,035
Cubierta escasa (60%) 0,15-0,09
Cubierta inapreciable 045

ANEXO 3

Valores de P correspondiente al tipo de practicas de conservacion, segn Taipe 2001

PRACTICA DE CONSERVACION Factor P
Cultivo a nivels =0 -1° 0.60
Cultivoanivels =2 -5° 0.50
Cultivoanivels=6-7° 0.60
Cultivo anivels =8 -9° 0.70
Cultivo a nivel s =10 - 11° 0.80
Cultivo anivel s =12 - 14° 0.90
Bancales a nivel 0.14
Bancales a contra pendiente 0.05
Bancales con pend. Siguiente la pend. 0.35
Bancales anivel con referencia de agua 0.01
Caballones enlazados 0.10-0.20
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ANEXO 4
Descarga del programa SNAP (Fuente: Tomado de STEP s.f.)

Home > Download > SNAP Download

SNAP Download

Here you can download the latest installers for SNAP and the Sentinel Toolboxes.

Data provision is available to all users via the Sentinel Data Hub.

Current Version

The current version is 7.0.0 (22.07.2019 13:30 UTC).

For detailed information about changes made for this release please have a look at the
release notes of the different projects: SNAP, S1TBX, S2TBX, S3TBX, SMOS Box, PROBA-V
Toolbox

We offer three different installers for your convenience. Choose the one from the following
table which suits your needs. During the installation process, each toolbox can be excluded
from the installation. Toolboxes which are not initially installed via the installer can be later
downloaded and installed using the plugin manager. Please note that SNAP and the
individual Sentinel Toolboxes also support numerous sensors other than Sentinel.

Windows 64-Bit | Windows 32-Bit | Mac OS X | Unix 64-bit

Sentinel These llers contain the Sentinel-1, Sentinel-2, S. inel-3 Toolb
Toolboxes ( pownload ) | wnl | Download | Download
S ———

ANEXO 5
Descarga de la herramienta Sen2Cor (Fuente: Tomado de STEP s.f.)

For any questions about the usage of Sen2Cor, please follow the general STEP forum area

dedicated to Sen2Cor: http://forum.step.esa.int/c/s2tbx/sen2cor.
Latest release:

s 2.5.5 - It was released on March 23, 2018. This version runs on the operating
systems: Linux, Mac OSX and Windows (64 bit is mandatory). For details about the
features and fixes, see the release note.

o Standalone installers:
Windows installerﬁznZCor-Oz.05.05-win64.zi§ >
Linux installer: Sen2Cor-02.05.05-Linux64.run

Mac installer: Sen2Cor-02.05.05-Darwin64.run

Detailed information on all changes implemented in the new format of Sentinel-2 L2A
product is available in the dedicated documentation online: Sentinel-2 Products

Specification Document (PSD)

Release Note: S2-PDGS-MPC-L2A-SRN-V2.5.5.pdf
Software User Manual: S2-PDGS-MPC-L2A-SUM-V2.5.5 V2.pdf

Sentinel-2 Level 2A Product Definition: $2-PDGS-MPC-L2A-PDD-V2.5.5.pdf
Sentinel-2 Level 2A Input Output Data Definition: S2-PDGS-MPC-L2A-I0DD-V2.5.5.pdf
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e ANEXOG6

Archivos descargados por cada imagen satelital

AUX_DATA Carpeta de archivos
DATASTRIP Carpeta de archivos
GRANULE Carpeta de archivos
HTML Carpeta de archivos
rep_info Carpeta de archivos
[ ] INSPIRE /07/2 Documento XML 19KB
| ] manifest.safe 2 Archivo SAFE 52 KB
m 4/07 Documento XML 44KB
e ANEXO7
- Ubicacion de la herramienta Sen2Cor
H [1] 524 _MSIL1C_20170723T152641_N0205_R025_T17LRK_20170723T132915 - [EABACKUP\Desktop'\Mueva carpeta\524_MSIL1... — O
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help |0.' Search (Cirl+1)
: 3 g i GCP v i
LI LY N reQ ANV ERYE
| Spectral Unmixing
& | Product Explarer < Geometric > (=Y
= 23 MS 237152641 N
% Ela _mA__‘IL D170723T152641_NO| Preprocessing 3 g:_
Metadata - -
§ 523 Vector Data | Thema-tfc Land Pmcessujg- > Soil Radiometric Indices E—"
= -3 Bands Thematic Water Processing > Vegetation Radiometric Indices ] =
- -3 sun Water Radiemetric Indices > =
"_% 33 view | Sen2Cor ;
3
2 B 51(330m) MERIS/(A)ATSR SMAC Atmospheric Correction p
I Bl 52 (420 nm) ) ] 2
.g B 53 (550 rm) Biophysical Processor (LAl fAPAR...) %
= Py i}

- Seleccién de archivo

El sEN2COR

File Help

I/O Parameters  Processing Parameters

Source Product
Source product:

[1] 52A_MSIL1C_20170723T152641_N0205_RO25_T17LRK_20170723T15... -~

[1] S2A_MSIL1C_20170723T152641 N0205_R025_T17LRK_20170723T152915
[2] S2A_MSIL1C_20170703T152641 M0O205_R025_T17LR]1_20170703T153040

I Run || Close || Help |




- Seleccién de la resolucion de 10 m.

8 SEN2COR x
File Help
I/0 Parameters Processing Parameters

Display execution output

[] Scene only
Resolution: 60
[] €r enly
20
L2A_GIFF file 50

(If & file is selected, aLL
the parameters below -
£ >

Cloze Help

- Archivos resultantes en el Nivel-2a

S2A_MSIL2A_20170723T152641_N0205_R025_T17LRK_20170723T152915.SAFE
S2A_MSIL2A_20170703T152641_N0205_R025_T17LRJ_20170703T153040.SAFE
S2A_MSIL1C_20170723T152641_N0205_R025_T17LRK_20170723T152915.SAFE
S2A_MSIL1C_20170703T152641_N0205_R025_T17LRJ_20170703T153040.SAFE
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e ANEXOS8

- Seleccién de Mosaicing

Raster Optical Radar Tools Window Help

Band Maths... I Qﬂ‘? @g & GCE N

Filtered Band...

al Colors RGE %

Convert Band
Propagate Uncertainty...

Geo-Coding Displacement Bands...

Subset...

Geometric Operations * Level-3 Binning
DEM Tools > | Mosaicing

Masks ¥ Reprojection

Data Conversion * Resampling
Image Analysis i Multi-size Mosaic
Classification ’ Collocation

Segmentation »

- Ventana de Mosaicing

E. Masaicing
File Help

Pestafia de pardmetros
de entrada y salida
5| Map Projection Definition  Variables & Conditions
Source Products

b =

5\COPERNICUS \ok\Nugva carpeta\524_MSIL24_20170703T 152641_N0205_R025_T17LR)_20170703T 1530
5\COPERNICUS \ok\Nueva carpeta\52A_MSIL2A_20170723T 152641_N0205_R025_T 17LRK_20170723T 152¢

Imagenesaunir en

formato BEAM-DIMAP

Mombre del
archivo de salida

Formato del
Save ax: |EERET archivo de salida
Directory:

E:\BACKUP\Desktop\Nueva carpeta\Mew Folder

[#] Open in shap Direccion
desalida
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Pestafia de Proyeccion Geogréfica

i Mosaicing

File Help

1/O Parameters | Map Projection Defirvtion| variables & Conditions
Coordinate Reference System (CRS)
(®) Custom CRS

Geodetic datum: World Ge

Projection: UTM / WGS 84 (Automatic)

() Predefined CRS

Orthorectification
[] Orthorectify input products
Elevation model: SRTM 3Sec

Mosaic Bounds
West: +78,54641619 ° East: +77.04102682 | ° Pixel size X: 10.0 ' m
North: -8.764119 * South: -11.10613136 | Pixel size Y: 10.0'm

[] Display source products

=
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- Pestafa de Variables y Condiciones

A Mosaicing x
File Help
1/0 Parameters  Map Projection Definiton  Variables & Conditions
Variables
bhd o5 &5 @
MName Expression
2 7 [...]
B3 Bandas seleccionadas
B4 B4 para el producto final
B3 B2
quality_scene_das... K X
Conditions
P o & B
Name Expression Output
Combine: Boton para correr
el proceso
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e ANEXO9

- Mascara de la cuenca Huarmey

- Pestafia de los pardmetros de entrada y salida

& Land/Sea Mask X

File Help

IO Parameters  processing Parameters

Source Product

source: Se ingresa el mosaico

[1] mosaic v

Target Product

Name:

producto final

mosaic_msk 0 0 de

Save as: | BEAM-DIMAP - R

Directory:
E:\BACKUP\Desktop'\Nueva carpeta\

Open in SNAP Ruta de salida |

Close
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Pestafia de pardmetros del procesamiento

€ Land/Sea Mask X
File Help
1/O Parameters Processing Parameters
Source Bands:
- Bandas que tendra
B3_count = q
; la imagen final
(C) Mask out the Land
(C) Mask out the Sea
/] Use SRTM 3sec Archivo del poligono
e
@ Use Vi dela cuenca
se Vector as Mask
|Cueru3_|-ba111ey_ v ]
[] Invert Vector
Extend shoreline by [pixels]: |
Boton para
correr el proceso
. | Run | l Close J
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e ANEXO 10

- ROI’s de la cuenca Huarmey

3 . N

Et;/ Regions of Interest R

g LAGUNA gion of Interest (ROI) Tool > 4
Mt QUEBRADA File

M=l MONT ALTA '

MONTMEDVEG | ™ B 3 @ B RELEEEELE)
M MONTARA

@ ARENA ROI Name: LAGUNA v
Mt AGRIC SIN CULT
Mt ARBOL * | Geometry Pixel Grow Threshold

: % Q?OR'COLA IZ @r =

~Ediah URBANA CoMatiPat [ Vertex Snap
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e ANEXO11

UNIVERSIDAD NACIONAL AGRARIA LA MOLINA
FACULTAD DE AGRONOMIA
LABORATORIO DE ANALISIS DE SUELOS, PLANTAS, AGUAS Y FERTILIZANTES

INFORME DE ANALISIS ESPECIAL EN SUELO

SOLICITANTE : LIZBETH ROCIO CAYCHO TORRES

PROCEDENCIA  : ANCASH/ HUARMEY/ HUAR

REFERENCIA : H.R. 69152
BOLETA S 060)
FECHA . 18/07/2019
Numero Muestra Arena Limo Arcilla Clase M.O.
Lab Claves % % % Textural %
2411 | Muestra 1, Huiia Huarmey, 0-45 cm. 47 34 19 Fr. 0.54
g L R 26 17 FrA 132
e o e | s e
2414 Muestr: :a wsneec;,t,o(r)-l\:gr::arn CFristina 93 2 5 A 0.02
2415 "“S‘:;gffygi‘b:‘r’; e 12 9 FrA 0.15
2416 Muestra 6, sgjgfc'::ya-Huarmey. 93 2 5 A 0.02
Muestra 7'::;%?,’:“““”“ 47 32 21 B
Muestra 8, S;ga::::lo Huarmey, & | 2 45 | EpAl : _—éﬂ
. ‘Muestra 9, Pto. Huarmey, 0-45 cm. 57 32 O # ;

= Arena Franca ; Fr.A. = Franco Arenoso ; Fr. = Franco ; Fr.L. = Franco Limoso
= Franco Arcillo Limoso ; Ar,
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UNIVERSIDAD NACIONAL AGRA
FACULTAD DE ,-\(’.‘RON()MI?\{[A BAMOIILL

LABORATORIO DE ANALISIS DE SUELOS, PLANTAS, AGUAS Y FERTIL IZANTES

INFORME DE ANALISIS ESPECIAL EN SUELO

SOLICITANTE . LIZBETH ROCIO CAYCHO TORRES

PROCEDENCIA : ANCASH/ AlJA

REFERENCIA © H.R. 69255

BOLETA . 3304

FECHA : 26/07/2019

Numero Muestra Arena Limo Arcilla Clase

Lab Claves % % % Textural
2694 M-1, Aija - Aija. Prof. 0-45 cm. 66 16 18 Fr.A.
2695| M-2, Succha - Aija, Prof. 0-45 cm. 74 16 10 FrA.
2696 | M-3, Huacllan - Aija, Prof. 0-45 cm. 74 12 14 Fr.A.
2697 [ M-4, Huacllan - Aija, Prof. 0-45 cm. 54 16 30 Fr.ArA.
2698 | M-5, Coris - Aija, Prof. 0-45 cm. 44 28 28 Fr.Ar.

A= Arena ; A Fr. = Arena Franca ; Fr.A. = Franco Arenoso ; Fr. = Franco ; Fr.L. = Franco Limoso ; L = Limoso ; Fr.Ar.A. = Franco Arcillo

Arenoso ; Fr.Ar. = Franco Arcilloso; Fr.Ar.L. = Franco Arcillo Limoso ; Ar.A. = Arcillo Arenoso ; Ar.L. = Arcillo Limoso ; Ar. = Arcilloso

Numero Muestra M.O.
ab Claves %
2694| M-1, Aija - Aija, Prof. 0-45 cm. 4.97

2695 | M-2, Succha - Aija, Prof. 0-45 cm. 3.45
2696 | M-3, Huacllan - Aija, Prof. 0-45 cm. 2.30
2697 | M-4, Huacllan - Aija, Prof. 0-45 cm. 0.58
2698 | M-5, Coris - Aija, Prof. 0-45 cm. 1.75

fe del Labpratorio

*&f mo-La-10ofre iarurnez

Av. La Molina s/n Campus UNALM
Telf.: 614-7800 Anexo 222 Teléfono Directo: 349-5622
e-mail: labsuelo@lamolina.edu.pe
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